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ALGEMEEN

MEDIA INFO
Media Info is een gratis te downloaden
programma, waarin je de gegevens van
een bestand/film kunt bekijken. Onze
archivaris gebruikt het om onze video’s
te controleren. Hier wordt ook regel-
matig ontdekt, dat met een te hoge bit-
rate geëxporteerd is, waardoor de opge-
merkte problemen zijn ontstaan.
Het programma geeft uitsluitend gege-
vens weer. Je kunt er verder niets mee.

Je kunt er een bestand in binnenhalen
om de gegevens te bekijken, maar ook
zie je de gegevens door simpelweg
rechts te klikken op het bestand en
voor MediaInfo te kiezen. Bij de opties
kun je de instellingen zelf bepalen. Door bij die instellingen ‘tekst’ te kiezen, krijg je stan-
daard alle gegevens, die wij voor video interessant vinden te voorschijn.

VAN AVI NAAR MP4 EN BESTANDSGROOTTE
Vraag: >> AVI-bestand van 3,29 GB  - 25 beeldjes - 15,31 minuten

   >> Mp4-bestand van 798 MB  - 25 beeldjes - 15,31 minuten
Afgezien het (eventuele) visuele verschil in beeldkwaliteit van beide eindresultaten vraag ik
mij af of de omzetting van een (AVI) bestand van 3,29 GB naar een (Mp4) bestand slechts (!)
798 MB mag opleveren. Zo nee, aan welke knoppen moet ik dan draaien om een hoger MB
resultaat te krijgen uiteraard (?) met een hopelijk beter visueel resultaat. Of het lagere (?) MB
resultaat helemaal niet zalig makend voor het visuele eindresultaat?

Antwoord: AVI-films zijn ongecomprimeerd en MP4-films zijn gecomprimeerd. Het is dus
logisch, dat het bestand kleiner wordt.
Ik heb even een paar dingen gecontroleerd bij films van mezelf:
Opening Beatrixschool: AVI = 3.53 GB - 720:576 werd in MPG (groter bestand dan MP4)
1,86 GB en ook nog overgezet naar 1440:1080 (groter beeldformaat).
Een dagje Delft was in AVI = 1.18 GB - 720:576. Deels hergemonteerd met groter formaat
afbeeldingen en overgezet naar MP4 met beeldformaat 1920:1080. Dit bestand werd wel gro-
ter: 1.23 GB.
Over het algemeen zie ik een duidelijke vermindering van het aantal MB's, dus dat lijkt me
zeker niet onlogisch. Kijk vooral naar de beeldkwaliteit, die er uit komt en schrik niet van de
lagere MB's.

GEEN DVD, MAAR MEDIAPLAYER
In verband met een probleem met het branden van een DVD vanuit Studio is ook het gebruik
van een Mediaplayer ter sprake gekomen. Diverse leden hebben een tv, waarbij het gebruik
van de usb-sticks problemen geeft. Wij en nog een paar andere leden hebben daarom een me-
diaplayer aangeschaft. De meesten zijn betaalbaar en spelen alle gebruikelijke bestanden af. Je
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bewaart je films dan op een harde schijf in de mediaplayer of een externe harde schijf.. Na-
tuurlijk kunnen ook usb-sticks gebruikt worden.

HELP, KAPOTTE DV-CAMERA
Veel leden hebben door Corona het digitaliseren van oude banden opgepakt. Verschillende
leden kregen problemen met hun DV-camera. Ze vragen mij dan om een oplossing. Wel voor
reparatie kun je uitstekend terecht bij onze adverteerder Rob Taihutu van Rotronica. Je hoort
dan vanzelf of het voor jou nog betaalbaar is. Een andere optie is om eens rond te vragen bij
de club, of er nog mensen zijn, die een camera hebben, die ze niet meer gebruiken. Of wat
denk je van een rommelmarkt, al is dat in deze coronatijd misschien geen optie. Marktplaats
o.i.d. kan ook nog.

CLIPS VERBETEREN MET KLEURCORRECTIE EN GRADING
Acht-bit video werkt op een schaal van 0 tot 255. Dat betekent dat elke pixel ergens op die
schaal rode, groene en blauwe (RGB) waarden heeft, die samen een bepaalde kleur produce-
ren. Je kunt het zien als 0% en 255 als 100%. Een pixel met een rode waarde van 127 komt
overeen met een rode waarde van 50%. We hebben het echter over RGB-afbeeldingen. Voor
televisie wordt een vergelijkbaar maar ander bereik gebruikt met een kleursysteem met de
naam YUV.
Een computerscherm is echter RGB.
Als je video voor weergave op televisie
produceert, kan dit problemen veroorza-
ken, omdat je naar  videobeelden op een
ander soort scherm kijkt dan het soort,
waarop ze uiteindelijk worden bekeken.
Verbind een tv of een tv-monitor met je
bewerkingssysteem en bekijk de beelden
op dat scherm. Het verschil is een beetje
als het vergelijken van een foto, die je op
een computerscherm bekijkt met een ge-
printe versie. De  printer en het compu-
terscherm gebruiken verschillende kleur-
systemen en het is een onvolmaakte vertaling van de ene naar de andere. Soms bekijk je beel-
den met zichtbare details op een RGB-scherm, zoals het scherm van uw computer. Dat verd-
wijnt wanneer het op een tv-scherm wordt bekeken. U moet de kleur aanpassen om deze de-
tails op het tv-schermbereik te krijgen. Sommige tv's geven u de mogelijkheid om kleuren
weer te geven als RGB, met een reeks namen zoals Spelmodus of Fotokleurenruimte. Als uw 
scherm op deze manier is ingesteld, ziet u mogelijk het volledige RGB-bereik van 0 tot 255.

Je hebt waarschijnlijk wel gehoord van zowel kleurcorrectie als color-grading (kleuraanpas-
sing). Er is vaak verwarring over het verschil. Beide typen werken in feite met dezelfde hulp-
middelen, maar er is verschil van aanpak. Kleurcorrectie is meestal gericht op het standaardi-
seren van de opnamen om ervoor te zorgen dat ze bij elkaar passen en om het uiterlijk in het
algemeen te verbeteren met helderdere “hooglichten”(Highlights) en sterkere schaduwen
(Shadows) te geven of om een in de camera vastgelegde kleurcorrectie te verbeteren. Dit is
meer ambacht dan kunst. Kleuraanpassing is gericht op het bereiken van een “look”, die de
sfeer van het verhaal vollediger weergeeft.Dit is meer kunst dan ambacht. Er is een debat over
waar het ene eindigt en het andere begint.
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Waarom kleurcorrectie of -aanpassing? Dat antwoord is snel gegeven. Om je beelden dynami-
scher te maken of een bepaalde emotie te geven, andere punten zullen zijn:
Het verhelpen van
< te weinig contrast in je beelden
< te lage belichting
FOTO’S OF AFBEELDINGEN KOPIËREN VANUIT GOOGLE
Type in de zoekbalk van Google het woord van de afbeelding of foto, waar je naar op zoek
bent, bv. Het wapen van Amsterdam. Je ziet dan veel sites over Amsterdam, maar die heb je
nu niet nodig.
Onder de zoekbalk staan diverse mogelijkheden zoals: Alle, Maps, Afbeeldingen enz.
Klik op Afbeeldingen en je krijgt alle foto’s van het wapen te zien. Niet alle foto’s zijn ge-
schikt om te gebruiken, omdat er foto’s met kleine bestanden tussen staan.
Ga nu weer onder de zoekbalk naar Tools en klik die aan. Direct onder die regel verschijnt nu
een nieuwe regel met Grootte > Kleur enz. Klik Grootte aan en in het uitrolmenu klik je nu
op Groot. Je krijg dan alleen de foto’s of afbeeldingen te zien met een hoge resolutie. Zoek de
goede afbeelding uit en klik hierop. Nu verschijnt de foto rechts in een nieuw menu (Windows
10). Klik nu weer op de foto met de rechtermuisknop en klik op Kopiëren of Afbeelding op-
slaan als…
Ga nu naar het bureaublad en plak de foto of afbeelding in het bureaublad.
Als je verder geen bewerkingen meer wilt uitvoering sleep dan de foto naar de map Afbeel-
dingen op je bureaublad voor het importeren naar Studio.
Wil je de foto bewerken zoals belichting, kleur of een uitsnede maken, dan heb je O.a. Photo-
shop nodig. Als die bewerkingen dan klaar zijn, dan alsnog de foto naar de map Afbeeldingen
slepen.

FILM MET EN ZONDER GELUID
Vraag: Ik heb een filmpje van mijn broer. Bij het ene filmpje krijg ik beeld en geen geluid.
Bij het andere krijg ik zowel beeld als geluid. Het gaat over hetzelfde filmpje. Mijn vraag:
Hoe kan dit? Het gaat om oude familiebeelden, die voor ons waardevol zijn.
Antwoord: We hebben de gegevens, die MediaInfo weergeeft van beide films naast elkaar ge-
legd. Het filmpje zonder geluidsweergave is een WMV-bestand en het goede filmpje een
MP4-bestand. Beide bestanden zijn codecs, waarbij de films gecomprimeerd worden. Bij het
MP4-filmpje wordt ook gecomprimeerde audio (MP3) gebruikt, bij de WMV wordt een onge-
comprimeerd bestand gebruikt. Mogelijk ligt daar de oorzaak en hebben beeld en geluid
daardoor ‘moeite’ om met elkaar in de pas te lopen.

SCHOKKERIGE BEELDEN Div. programma’s
Vraag: Ik heb 3 voorbeelden van een stukje film, gefilmd
met een gimball. De beelden zijn prachtig en stabiel, maar in
Adobe Elements of Adobe Pro worden de panoramabeelden
stotterend.

Antwoord: Ook hier weer de bestandsgegevens zichtbaar ge-
maakt met mediaInfo. We zien dan bij opname 1:

Bij opname 2:

SGD Uitleg 2019_20 5 of  61



Duidelijk is dat beiden opgenomen zijn met 30 beeldjes per seconde (NTSC) en dat is niet
vreemd, want bijna alle mobiels nemen zo op. Wat wel opvalt is de variabele frameratemodus.
Zie hierboven. 

Wikipedia geeft aan:
Variabele framesnelheid (of VFR) is een term in videocompressie voor een functie, die
wordt ondersteund door sommige containerindelingen, waarmee de framesnelheid
actief kan worden gewijzigd tijdens het afspelen van video, of om het idee van de fra-
mesnelheid volledig te laten vallen en een individuele tijdcode in te stellen voor elke
gestel. [1] [2] VFR is vooral handig voor het maken van video's van presentaties van
diavoorstellingen of wanneer de video grote hoeveelheden volledig statische frames
bevat, als een manier om de compressiesnelheid te verbeteren, of als de video een
combinatie van 24/25/30/50/60 FPS-videobeelden bevat en de maker of editor van de
video wil artefacten vermijden die voortkomen uit framerate-conversie.

Hierbij zou je dus zeggen, dat dit juist de stabiliteit ten goede komt. Anders dan de ervaringen
van de maker.

We kijken wat voor instellingen de montage heeft meegekregen. We zien dan:

Hier wordt een constante Frameratemodus gebruikt. Los daarvan (en dat houden we even aan)
is de film overgezet op 24fps. Vraag is dan meteen: “waarom 24 beelden?” Immers in onze
PAL-versie werken we doorgaans met 25fps of 50fps.
We zien in de beelden, dat de bewegingen van de pans en de tilts enige schokkerigheid verto-
nen. Een simpele logische verklaring zit in een rekensommetje. Je maakt verlaagt het aantal
beelden per seconde van 30 naar 24. Dus minder beelden per seconde.

Proef Studio - tijdlijn 24fps. Zelfde resultaat.
Proef Premiere en ook Studio - tijdlijn 1080 50p. Geen schokken.

Advies: gebruik in zo’n geval 1080 50p.
Zijn alle gebruikte beelden opgenomen met dezelfde smartphone o.i.d met 30fps. Doe niet
moeilijk. Houdt gewoon dezelfde framerate aan. Exporteer het ook daarin. Elk apparaat hier
in Nederland kan het gewoon afspelen.
*Tip: bij Premiere kun je door simpelweg rechts te klikken op het videobestand in het project-
venster kiezen voor “Make sequence from clip”. Je clip komt dan in de tijdlijn te staan met de
juiste instellingen.
*Noot: natuurlijk worden alle soorten bestanden door bijna alle montageprogramma’s ‘ge-
slikt’, hoe de tijdlijn ook ingesteld staat. Dat wil nog niet zeggen, dat in al die gevallen proble-
men als hierboven beschreven niet zullen voorkomen.

DE VOICE-OVER
Over het maken van een voice-over hebben we al vaak gesproken en over de zaken, waar we
op moeten letten is al veel gesproken en geschreven. Maar nu komt de praktijk. Daarvoor
hieronder een paar tips:
• Bekijk de film op de tijdlijn en bedenk, wat je wilt zeggen
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• Type de tekst uit
• Draai film af op de tijdlijn, terwijl je de tekst uitspreek
• Let op, of het goed bekt (spreektaal) en of het klopt met de lengte van de beelden.
• Pas waar nodig de tekst aan tijdens dit proces
• Tevreden? Zorg dan dat de aangepaste tekst in een goed leesbare letter op papier staat

en spreek in
• Ga je in de fout. Even een paar tellen pauze en opnieuw dit deel inspreken
Noot: over de voice-over staat een uitgebreide uitleg op het ledendeel van de website. Zal ook
later nog altijd bij Joke verkrijgbaar zijn.
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COMPUTER

MONTAGEPROGRAMMA, DAT MIJN LAPTOP AAN KAN
Vraag: Nog steeds ben ik op zoek naar goede software, waarmee ik films kan maken en waar-
van het volume niet te groot is voor mijn laptop. Momenteel gebruik ik het systeem NCH,
maar daar ben ik niet weg van. Ik zit te denken aan Adobe Elements. Vraag is of deze geschikt
is voor mijn laptop Lenovo V 110. Bijgaand vind je de technische gegevens. Mocht je nog een
alternatief idee hebben, dan houd ik mij hiervoor aanbevolen.
Antwoord: Op de laptop werd eerder gebruik gemaakt van Pinnacle Studio, maar dat gaf erg
veel problemen. Bij de gegevens lezen we, dat de laptop is uitegerust met een Intel Core i3-
6006U processor, 1TB harde schijd, WLAN ac, 4GB geheugen en een IntelHd graphics 520
grafische chip. Dan wordt meteen al duidelijk, dat de laptop niet geschikt is voor videobewer-
king. Immers er zit slechts een i3 processor in. Het is dan een goede computer voor basisbe-
werkingen en niet meer. Het installeren van welk videomontageprogramma dan ook, zal geen
probleem geven, maar zodra je ermee gaat werken, dan ontstaan de problemen. Immers, dan
dient er gerekend te worden en dan heeft het apparaat te weinig rekenkracht.

Hieronder de gegevens nodig voor Premiere Elements:
Adobe Premiere Elements 2019
Windows
• Processor van 2 GHz of sneller met SSE2-ondersteuning; Dual-Core-processor voor

HDV-bewerking; Intel Core i7 en 16 GB RAM voor XAVC-S (4K-bewerking)
• Microsoft Windows 7 met SP1, Windows 8.1 of Windows 10 (aanbevolen)
• 64-bit OS (32-bit niet ondersteund)
• 4 GB RAM (8 GB aanbevolen)
• 6.1 GB beschikbare vasteschijfruimte om de toepassingen te installeren; extra vrije

ruimte nodig tijdens installatie
• 10 GB om alle optionele inhoud te downloaden
• Weergaveresolutie 1280 x 800 (bij schaalfactor 100%)
• Met Microsoft DirectX 9 of 10 compatibel stuurprogramma voor geluid en monitor
• Dvd-rom-station (bij installatie vanaf dvd)
• Compatibele dvd-brander om dvd's te branden
• Windows Media Player (vereist voor importeren/exporteren van Windows Medi-

a-indelingen)
• Internetverbinding vereist voor het activeren van het product en het downloaden van

inhoud*
• Ondersteunde browsers: Microsoft Internet Explorer 9 t/m 11, Mozilla Firefox 4 of

later, of de laatste versie van Google Chrome

PROLETARISCHE PROGRAMMA’S
We kennen ze allemaal, de proletarische programma’s met een crack. Natuurlijk gebruiken we
ze geen van allen, maar toch een paar tips.
Als je een dergelijk programma installeert, dan is het over het algemeen verstandig om inter-
net tijdelijk uit te schakelen, maar ook de beveiliging. Deze laatste kan er namelijk voor zor-
gen, dat de crack nauwelijks te zien is en dan direct verwijderd wordt. Dit gebeurt als je crack-
bestand op de computer staat, of op een usb-stick. Hij kan nooit verwijderd worden van een
DVD- of Blurayschijf.

SGD Uitleg 2019_20 8 of  61



Ook het antivirusprogramma Defender van Windows is een beveiliging, dus ook even uitscha-
kelen. Overigens .... het programma Defender is op dit moment zo goed, dat een extra antivi-
rusprogramma installeren totaal overbodig is.
Niet vergeten na installatie de beveiliging weer te activeren.

WINDOWS DEFENDER UITSCHAKELEN
Klik in de linkerhoek van de taakbalk op het Windows-logo en vervolgens op Instellingen. Er
opent zich een nieuw venster. Hier selecteer je de categorie Bijwerken en beveiliging. Klik in
het menu aan de linkerkant op
Windows Defender en vervolgens
aan de rechterkant op Windows De-
fender-beveiligingscentrum openen.
Klik op Virus- en bedreigingsbevei-
liging en vervolgens onderin je
scherm op Instellingen voor virus-
en bedreigingsbeveiliging.

Om Windows Defender uit te scha-
kelen, zet je het schakelaartje onder
Realtime-beveiliging op Uit.

WERKEN MET TWEE OF MEER PROGRAMMA’S IN EEN SCHERM
Soms is het handig om meerdere programma’s naast elkaar geopend te hebben en te zorgen,
dat je beide programma’s steeds in beeld hebt. Je kan dit als volgt realiseren.
Open een bepaald programma. Minimaliseer het programma met het vierkante kruisje rechts-
boven in het scherm van het programma. Het venster is aan alle kanten met de pijltjescursor
aan te passen.
Open een tweede programma via de verkenner of het bureaublad en zet die naast het andere
programma. Klik in het scherm, waarin je wilt gaan werken.
Doordat er twee bewerkingsvenster open staan, hoef je niet telkens op je papieren documenta-
tie te kijken.

MAPPEN MAKEN OP JE BUREAUBLAD Computer en Studio
Het is al eerder uitgelegd, maar ik ga het nog een keer doen, aangezien ik de laatste tijd heb
gezien er heel weinig wordt gedaan aan het organiseren van de videobeelden, die je ga gebrui-
ken in Studio (geldt ook voor andere programma’s).
We gaan ervan uit, dat alles in de map Video in de verkenner staat. Dit geldt ook voor de film-
beelden, die we niet gaan gebruiken in een projectfilm. Het niet onoverkomelijk, maar je
zoekt je rot naar bepaalde beelden, die je wilt gaan gebruiken.
Ik heb mijn externe harde schijf meegenomen, waar alle beelden op staan, die ik ooit heb ge-
maakt. Deze beelden blijven als mijn bibliotheek op de harde schijf staan en daar wordt nooit
mee gewerkt. Heb ik een of meerdere beelden nodig, dan maak ik daar een kopie van, zodat
de originele beelden altijd aanwezig blijven. Er kan dan niets mee gebeuren of mis gaan.

Om het altijd makkelijk is om alleen de beelden in de bibliotheek van Studio te hebben staan,
die je ook werkelijk gaat gebruiken, maak ik gebruik van mappen op mijn bureaublad. Je kunt
ook geanalyseerde mappen in het controle paneel instellen, maar dat vind ik zelf niet zo han-
dig. 

Uitleg voor maken van mappen.
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Maak een map Video op je bureaublad. Je kunt dit doen door rechts te klikken ergen op je
scherm en vervolgens Nieuw > Map te kiezen. In deze videomap komen alleen de mappen
met projecten waar je mee bezig bent. Elk project krijgt zijn eigen map.
Bijvoorbeeld map De Elzen, Dordrecht of een land.
In deze map worden weer  een mappen aangemaakt met Bomen, Dieren, enz. Op deze wijze
krijg je een duidelijke verdeling. Je kunt net zoveel mapjes maken als je wilt. Alle beelden
zijn dan geordend per film en zijn vervolgens gemakkelijk te importeren naar de bibliotheek
van Studio. 
Als je later nog filmbeelden hebt gemaakt, dan zet je de beelden eerst op je externe schijf en
kopieer je ze vervolgens naar de bepaalde map op je bureaublad. Dan volgt weer importeren
in Studio bijvoorbeeld snelle import. Je nieuwe beelden staan nu ook in je Studio-bibliotheek.

Voor Audio en Afbeeldingen geldt hetzelfde verhaal.

Op je bureaublad staan dan drie mappen, t.w. VIDEO, MUZIEK, AFBEELDING-
EN/FOTO’S. Uitsluitend daaruit importeer je je beelden naar de Studiobibliotheek.

Wil je later in de bibliotheek nog een filmpje toevoegen in een map in de bibliotheek, selec-
teer je even een andere film in die map (er komt een oranje kader omheen) en importeer dan
de bepaalde videofilms. De films komen dan automatisch in dezelfde bibliotheek map terecht.

Als je helemaal klaar bent, kun je alle mappen verwijderen. In je Studiobibliotheek komen
dan allemaal beelden met rode uitroeptekens te staan. Dit geeft aan dat de beelden zijn verwij-
derd. Alle frames met een uitroepteken kan je nu verwijderen. Het ruimt lekker op en de boel
blijft overzichtelijk.

Noot 1: een uitgebreide uitleg over het organiseren van de computer vind je in de uitleg van
2017 onder het hoofdstuk Computer.

Noot 2: Als je volgens bovenstaande uitleg - dus via het bureaublad - mappen aanmaakt, dan
komt alles op de C-schijf te staan in de daar bestaande map Gebruikers. Zoals we op de club
al aangaven wordt veelal geadviseerd om de C-schijf uitsluitend voor de programmering te
houden en een aparte schijf voor de data. Is je computer onderverdeeld in meerdere schijven
(virtueel, danwel echt), dan kun je map op je bureaublad aanmaken via een snelkoppeling.
Maak dan bijvoorbeeld een map aan in de verkenner op de door jou gekozen plaats, klik
rechts op die map en kies Snelkoppeling maken. Op deze wijze kun je zelf kiezen op welke
schijf je beelden komen te staan.
Alle volgende handelingen blijven gelijk.

PRINT SCREEN
Naar aanleiding van een vraag heb ik om een afbeelding van het scherm gevraagd, zodat je
een beeld krijgt bij de gestelde vraag. Hoe maak je zo’n afbeelding?

Een print screen is een afbeelding van het computerscherm. Met windows 10 doe je het als
volgt:

Toetsencombinaties voor screenshots
Het bekendste is de PrtScn-(Print Screen)-knop op het toetsenbord. Druk daarop en je krijgt
een plaatje van je hele bureaublad op het klembord. Daarna kun je dit met Ctrl+V direct plak-
ken in een beeldbewerkingsprogramma zoals Paint of paint.net. Alt+PrtScn werkt op dezelfde
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manier, alleen krijg je dan alleen een plaatje van het actieve venster. Windows+PrtScn daaren-
tegen slaat het hele bureaublad op als png-plaatje in de map
c:\Gebruikers\<gebruikersnaam>\Afbeeldingen\Schermopnamen. Die kun je in de Verkenner
snel vinden via Afbeeldingen \ Schermopnamen.

Screenshot maken met Knipprogramma
Windows 10 heeft bovendien het
‘Knipprogramma’ (‘Snippingtool’).
Daarmee kun je door een rechthoek
te trekken het gewenste oppervlak
selecteren. Dit komt dan automatisch
op het klembord terecht. Je kunt dat
met elke vorm doen, maar standaard
staat een rechthoek ingesteld. Om
het Knipprogramma te starten druk
je op de Windows-toets en typ je
‘knip’. Het verschijnt dan bovenin
de lijst.

Als je sowieso alleen een rechthoekige uitsnede wilt hebben, kun je het programma nog snel-
ler starten met Windows+Shift+S. Dan start het Knipprogramma in de achtergrond zodat je
direct een rechthoek kunt trekken. Zodra je de linker muisknop weer los laat, gaat het geselec-
teerde beeld naar het klembord.

SGD Uitleg 2019_20 11 of  61



MONTAGEPROGRAMMA’S

TIPS div. programma’s
Een paar opmerkingen n.a.v. de uitleg van de afgelopen dinsdag. Niet om te betweteren, maar
gewoon ter aanvulling.

De video over een goedkope monitor voor je camera, zoals op de club vertoond en waarover
gesproken, is te vinden op de website van videoclub De Geinfilmers.

Sla ook de oude uitleg, zoals we die per jaar hebben gemaakt eens na. Uitleg van alle jaren is
nog bij mij te krijgen. Je vindt dan:

1. In de uitleg van 2015 een uitgebreide uitleg met de diverse functies, maar ook de ande-
re effecten voor het werken met blue of green screen. 

2. Uitleg over bezier, lineair etc. Weet even niet in welk jaar, maar vast en zeker gemak-
kelijk via de inhoud te vinden.

3. In de uitleg van Studio kwam kopiëren van een frame en groep frames ter sprake. Tip
hiervoor: het kopiëren van een frame of een groep frames kan ook door middel van
slepen met ingedrukte CTRL-toets. Bij Premiere en diverse andere programma’s ge-
bruik je de muis met ALT-toets. Ook dit is terug te vinden in de oude uitleg.

4. Een vliegroute, autoroute, vaarroute is in eerdere jaren ook besproken. Gebruik ge-
maakt werd van After Effects, Premiere en een routeprogramma. Terug te vinden in
verschillende jaren van de jaarnaslag.

5. Ook een mooi voorbeeld van tekst, die tussen de lagen doorloopt, zoals bij de onder-
gaande zon is in oude naslag te vinden. Het effect is ooit naar tevredenheid toegepast
bij de aftiteling van de film over de Orchestvereeniging.

NIEUWE VERSIE VAN ZOJUIST GEMAAKTE FILM MAKEN Alle programma’s
Vraag: Ik heb de film klaar, waar we over gesproken hebben. Nu wil ik er een andere versie
van maken, waarbij ik er o.a. wat persoonlijke dingen uitlaat. Kan ik die gemaakte film ge-
woon weer bewerken?
Antwoord: Dat kan, maar dan zit je wel met beperkingen. De film is een geheel en daar zit je
aan vast. Veel handiger is het om het project, waarmee de film gemaakt is weer te opnenen.
Sla dit project vervolgens direct op met een andere naam via opslaan als of Save as. Je kunt
nu gewoon in dat project werken met gebruik van het originele materiaal. Als je klaar bent,
kun je via Exporteren je 2e filmversie opslaan.

PAN EN ZOOM VAN AFBEELDING Studio
In Pinnacle Studio, vanaf 16, zit een apart tabblad om afbeeldingen in- of uit te zoomen en
zijwaarts e.d. te verplaatsen. We hebben dit al eens eerder behandeld.
Let wel dit geldt alleen voor afbeeldingen!

Als je een slechte of bewogen film hebt, die niet is te gebruiken, maak dan van een goed stuk
film een snapshot. Dit wordt dan een JPG, zodat je dan ook onderstaande kunt verwerken.

Voor video-zoomen ga je naar het tab-
blad effecten/camera en selecteer je
pan en zoom.
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Maar voor afbeeldingen zien we, als we de editor starten, dat er een tabblad Pan en Zoom bij-
gekomen is.
We plaatsen enkele afbeeldingen op de
tijdlijn en klikken rechts in de afbeel-
dingen. In het uitrolmenu selecteren we
Effect Editor openen of dubbel-klik in
de afbeeldingen.

Daarna selecteren we tabblad Pan en
Zoom en die start dan automatisch op
Static.

We zien een witte actieve ruit
om de foto en als ik de zoom-
factor vergroot zie je de rand
kleiner worden.

Als we met de muis de mid-
delste stip vastpakken kunnen
we de ruit naar de gewenste
plaats slepen. Maar dat kun je natuurlijk ook met het instellingscherm doen.

Klik op OK en nu zie je in het voor-
beeldscherm de uitsnede van deze foto.

Ik dubbel-klik opnieuw op de foto in de tijdlijn. De editor
start weer op en ik selecteer weer Pan en Zoom. Nu klik ik in
het instellingscherm op de knop Automatisch.

We zien nu een rode en groene ruit.

Ik verklein de groene ruit door met de z.g. hand-
vatten de ruit diagonaal te verkleinen en met de
middenstip plaats ik hem in de juiste positie.

Nu is er een witte lijn ontstaan en door de ro-
de punt te verplaatsen bepaal je de richting
van zoomen.
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Klik daarna op de playknop en we zien een extra witte ruit
over het beeld schuiven van de groene naar de rode ruit.

Dit is dus de zoomfactor, maar we kunnen de rode en groe-
ne ruit altijd weer verplaatsen en verkleinen om een mooi
begin of een mooie uitzoompositie te krijgen.

De andere functies, zoals links pannen, geldt weer voor de gehe-
le foto. We selecteren bij het instellingscherm links pannen.

We zien nu een witte en groene ruit over de foto en
het voorbeeldvenster geeft een half beeld.

Laat het effect even afspelen of verplaats de
scrubber naar rechts totdat je het midden
van de witte ruit ziet.

En trek bij het bovenste middelpunt de lijn naar beneden.

We zien nu een curve verschijnen, die door de foto gevolgd
wordt, maar die we ook nog weer kunnen veranderen.

Door even te experimenteren kunnen we de foto
alle kanten op laten bewegen.
Klik op Ok en zie het resultaat op de tijdlijn.

Een Pan en Zoom via deze functies kan je niet
te veel uitvergroten, want dat levert een slechter
beeld op.

Eerder hebben we al behandeld de 2D editor CPU effect. Hiermee kan je ook Zoomen en door
de CPU-functie blijft het beeld beter.

DE EFFECTEN EDITOR Studio
De meest gebruikte effecten

Klik eerst in de Effecten Editor het uitrolscherm open.
Bij Studio 16 t/m 19 is het rechtsklikken op het filmframe.
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Bij Studio 20 t/m 22 staat de Effecten Editor al gelijk linksboven,
naast de Bibliotheek.

Klik op de balk in het vakje
CPU.

Klik nu op het vakje 2D Editor CPU

Nu verschijnt het werkvenster met een gekleurde rand om de film en rechts een uitrolmenu.

De rand kan je in het uit-rolmenu van kleur ver-
anderen, maar deze functie wordt niet veel ge-
bruikt.

Klik in het uitrolmenu INSTELLING SELEC-
TER: Geen standaardwaarde. De rand verdwijnt
en je heb een volledig beeld.

Verdere mogelijkheden in het uitrolmenu zijn:

POSITIE:
Hiermee zet je het beeld in een gepaalde posi-
tie (naar links, rechts, boven of onder). Zo
kan je het beeld opschuiven zodat je b.v. twee
beelden in één scherm kan zetten.

Deze mogelijkheid zit ook in het Effect BIB,
maar dan heb je nog mogelijkheden om meer-
dere beelden in een scherm te zetten. BIB be-
handelen we later.

GROOTTE:
Klik op het slotje zodat het slotje Oranje wordt. 
De uitvergroting of verkleining gaat dan evenwijdig.
Voordeel van dit effect is dat het beeld door de CPU-functie veel
scherper blijft, in tegenstelling als in en uitzoomen.

(Engels: central processing
unit) 
of in het Nederlands “centrale verwerkingseen-
heid”.
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ROTATIE:
Hiermee kan je de film recht zetten of draaien.

BIJSNIJDEN:
Dit is makkelijk als je b.v. de film uitvergroot of weer met meerdere beelden in één scherm
gaat werken.

SPIEGELING:
Hiermee kan je film spiegelen.
Aanvinken
Flip Verticaal of Flip Horizontaal.

TRANSPARANTIE:
Met deze functie zet je twee beelden over elkaar
heen.
De transparantie kan je zelf bepalen.

In het beeld op de tijdlijn zie je een paarse lijn boven in het
beeld staan. 

Dit betekent, dat je een bewerking heb uitgevoerd.
Als met de rechtermuisknop op deze paarse lijn klikt, dan
krijg je weer een uitrolmenu, waarmee je het effect kan ver-
wijderen of bewerken.

EFFECT: BIB (Beeld in Beeld)
Met dit effect kan je meerdere film in het
beeld zetten.
Net zoveel als je wil en op elke plaats.

KEYFRAMES GEBRUIKEN BIB
Als we de functie keyframes gebruiken in Pinnacle Studio kunnen we een video/foto manipu-
leren met dezelfde functie.
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Dubbel-klik op de ingevoegde
clip of klik rechts in deze clip en
selecteer in het uitrolmenu
Effecten-editor openen.

De editor start op en we selecte-
ren dan tabblad Effecten/2D-3D
en zoeken het effect Beeld in
beeld op.

We zien het beeld al direct kleiner worden en we zien rechts een instellingsscherm, waar ik
alleen een rand toevoeg. Van de rand om het onderwerp kan je zelf bepalen hoe dik deze moet
worden en welke kleur hij moet krijgen.

Zorg ervoor dat de scrubber helemaal naar links
staat, bepaal de uitgangspositie van het onderwerp
en zet dan de knop keyframes aan.

Zet nu de scrubber op een eindje verder op de tijdlijn. Ga dan in het uitrolmenu het onderwerp
op een andere plaats zetten. Zodra je iets hebt veranderd, dan komt er in de tijdlijn direct een
nieuw keyframepunt. Herhaal dit zoveel je maar wilt.

Als we nu de tijdlijn afspelen zie je dit beeld naar links en daarna naar onderen en vervolgens
naar rechts verschuiven naar gelang hoe je de keyframe heb gezet.

We klikken op OK en zijn weer terug op de tijdlijn.

Met deze methode kunnen we allerlei combinaties bedenken en toepassen.

EFFECTEN EDITOR Studio 16 t/m 19.
De meest gebruikte effecten

De effecten-editor is vanaf Studio 16 bijna voor alle Studio’s hetzelfde. Als je de functies
éénmaal door hebt, dan kan je bijna alle effecten gaan maken.

We beginnen met de 2D-3D CPU functie. Alleen deze mogelijkheid heeft al vele functies.
We beginnen met een frame te selecteren. Het frame geeft een oranje lijn rondom het beeld
ten teken, dat het frame is geselecteerd.
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We klikken met de rechtermuisknop in het frame en er verschijnt een uitrolmenu. Boven in dit
scherm staat Effecten-Editor. Deze gaan we nu behandelen.

Klik het woord Effecten Editor aan met de linkermuisknop. Nu verschijnt het bewerkingsven-
ster van de Effecten-Editor. Vanuit hieruit zijn er diverse mogelijkheden, maar we beginnen in
de regel waar 2D-3D mee begint (1).
Klik met de muis 2D-3D aan en er verschijnt weer een regel met mogelijkheden in de 2D-3D
functie. Nu openen we weer de mogelijkheid van 2D editor CPU. Er verschijnt nu het frame
in een gekleurd kader en rechts in het scherm verschijnt ook een uitklapvenster. De gekleurde
rand is STANDAARD als je er mee begint.
We gaan nu eerst deze mogelijkheid nader bewerken.
We klikken nu op POSITIE in het rechter uitklapscherm en kunnen door met de balkjes te
schuiven een nieuwe positie bepalen, zowel horizontaal als verticaal.
Nu klikken we GROOTTE.
Als we op het slotje klikken wordt het slotje oranje en zodoende blijven  de verhoudingen ge-
lijk. Je kunt dus nu de positie en de grootte zelf bepalen.
De volgende functie is de ROTATIE.
Door met de muis in het balkje te gaan schuiven kan de het beeld draaien. Om het precies te
doen kan je ook het balkje selecteren en met de pijltjestoetsen de draaiing precies bepalen.
Volgende functie is de BINNENRAND.
Door met de balkjes te gaan schuiven kan de binnenrand breder en hoger maken. De binnen-
rand blijft gelijk, maar het beeld in het gekleurde kader wordt kleiner.
Functie ZACHTHEID geeft een zachte rand van het beeld in het kader.
De functie TRANSPARANT geeft een transparant beeld aan de zijkanten van het beeld in het
kader.

Ook de kleur van de binnenrand kan je veranderen. Standaard staat de rand op WIT. Je kunt
dit zien in het vakje, dat is wit gekleurd. Naast dit vakje staat een pipetje. Als je met het pipet-
je in het witte vakje klikt, verschijnt er een kleurenscherm en door in dat kleurenscherm te
klikken op een bepaalde kleur en TOEPASSEN aante klikken, krijgt de binnenrand die kleur.
Deze functie zit ook veel in andere functies die hetzelfde werken. 
De functie BIJSNIJDEN: hiermee kan je het beeld van de buitenrand bijsnijden zowel hori-
zontaal als verticaal.
De functie SPIEGELING: hiermee kan je het beeld spiegelen zowel horizontaal als verticaal.
De functie TRANSPARANTIE: hiermee kan je het hele beeld meer of minder transparant ma-
ken.

Dezelfde effecten kan je gebruiken in de functie NIET STANDAARDWAARDE.
Als je deze functie aanklikt, krijg je gelijk een volledig beeld en de verdere functies blijven
hetzelfde.
Bij INSTELLING SELECTEER zijn er nog mogelijkheden om met een voorkeur te werken.
De functie SCHADUW geeft het effect van BIB op een bepaalde plaats.

WERKEN MET TEKST EN DE VORMGEREEDSCHAP Studio 17+
We openen de Tekst Editor. Linksboven de tijdlijn in de
Tekst Editor staat een vakje met een kleine cirkel en een
vierkantje. Als we die aanklikken kunnen we diverse vor-
men aanklikken, zoals een rondje, vierkantje enz. Als we
als voorbeeld een cirkel aanklikken staat die gelijk midden
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in het beeld. Hierna kunnen we de vorm groter of kleiner maken.

Vlak naast het vormen icoontje staat een blokje met twee vierkantjes. Hiermee kan je de
vorm, als die is geselec-
teerd, rangschikken naar
achter of voren enz.
Net als bij de tekst kun-
nen ook de kleuren van de
vormen aangepast worden
via het rechter uitvouw-
menu en bij de kleurver-
loopfunctie.
Als je de tekst hebt bewerkt met vormen, dan kun je er een en snapshot van maken. Zorg wel,
dat de tekst apart op de tijdlijn staat en er geen filmframe onder staat, anders komt dat beeld
ook op de snapshot te staan. Een andere mogelijkheid is een print screen maken van de be-
werkte tekst. Maak die dan wel van een volledig beeld. (VOL SCHERM). De tekst/titel is dan
een afbeelding geworden en kan als afbeelding in de tijdlijn gebruikt worden. Je kunt er dan
vervolgens nog effecten op los laten. Let er wel op, dat je de oude titel met tekst en/of vorm
verwijdert.

We gaan de tekst laten bewegen.
Open de Effecten Editor, klik 2D-3D aan en daarna BIB aan. Het beeld komt meteen in de
rechterbovenhoek te staan. In het uitrolmenu ga je nu het tekstblok ook de plaats zetten, waar
je de beweging wilt starten. Zorg er voor de scrubber aan het begin van de tijdlijn staat. In het
uitrolmenu staat bovenin, naast het woord Studio BIB een heel klein ruitje. Deze is voor de
Keyframing. Klik deze aan en er kom een lijntje bij met een wit ruitje onderin het scherm. Dit
is de Keyframe van het effect BIB. Klik op het ruitje en in het uitrolmenu en vervolgens kan je
het ruitje verwijderen. Je verwijdert dan in feite het effect van BIB. Het lijntje verdwijnt nu.

Nu staat er weer een wit ruitje en dat is het begin
van het effect. Ga nu met de scrubber op de tijd-
lijn naar een plaats een eindje verder op. Dit is
afhankelijk van het aantal effectbewegingen, die
je wilt gaan maken.
Plaats nu het tekstblok op een andere plaats door
met Horizontaal of Verticaal te gaan schuiven.
Gelijk na het begin van de verplaatsing kom er

een wit kruisje op de lijn te staan en dat is dus de tweede Keyframe. Dit kan je net zoveel her-
halen, als je wilt. Wil je een Keyframe verwijderen, dan klik je weer in het witte kruisje op de
tijdlijn. In het uitrolmenu wind je Keyframe verwijderen. Klik dat dan aan.
Als je klaar bent met het plaatsen van de Keyframes, druk dan op OK en je bent weer uit de
Effecten Editor.
Wil je later toch nog aan het effect werken, klik dan weer rechts op het filmframe. In het uit-
rolmenu kan je o.a. kiezen voor Effect Bewerken. Je gaat dan terug naar De Titel Editor om de
aanpassingen te maken.

Heb je meerdere teksten of afbeeldingen, dan kunnen die allemaal apart een Keyframe-effect
krijgen, mits er maar een snapshot van is gemaakt. Later gaan wij uitgebreid de uitleg Van
Werken met Keyframing behandelen.
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Zowel filmbeelden als foto’s kunnen direct in de Effecten Editor worden bewerkt, maar dan
moet je wel het filmframe selecteren en de Effecten Editor open klikken en een bepaald effect
selecteren.

KEYFRAME EN VORMGEREEDSCHAP Studio17+
Klik de T aan om een tekst te maken, bv. SGD videoclub. Zet tijdelijk weer een tekst neer
naast de eerste tekst, maar verwijder de tekst, zodat er een leeg scherm overblijft. Ga nu hele-
maal links naar Vormgereedschap en selecteer een cirkel of een andere vorm. Maak die op de
juiste formaat en kleur en klik op OK.
Zet nu de cirkel boven het filmframe. Selecteer de cirkel en ga naar de Effecten Editor >
2D/3D > 2D Editor CPU. Automatisch staat het effect op Standaard met een rand om de film
heen. Verander dit in Geen Staandaardwaarde en de rand verdwijnt.
Ga nu met de scrubber helemaal naar rechts. Zet de cirkel via het uitrolmenu met Positie X
helemaal naar links, eventueel helemaal uit beeld. Klik nu rechtsboven het Keyframe Ruitje
aan en het eerste Keypoint wordt gezet. Zet nu de scrubber helemaal naar rechts. Ook eventu-
eel buiten beeld. Schuif nu met de Positie X horizontale schuif de vorm helemaal naar rechts. 
Automatisch wordt er een Keypoint gezet aan het einde van de film. Druk op OK.
De vorm loop nu van links naar rechts. Als je de tekst bovenin zet en de vorm er onder dan
loopt de tekst achter de vorm door.

Door het eerste Keypoint naar rechts te verplaatsen kan je het begin van de loop later in laten
gaan.

WERKEN MET VERDWIJNTEKST EN -FILMBEELDEN Studio17+
Zet de eerste film in de tijdlijn. Maak een tekst in de tweede tijdlijn, bv. SGD videoclub. Pas
deze aan naar lettertype, grootte en kleur en zet de tekst boven de film in de tweede tijdlijn.
De grootte kan je aanpassen via Corpsgrootte of de geselecteerde tekst bij de witte randen uit
te trekken met de muis. Maak de tekst naar keuze groter.
Zorg ervoor dat de scrubber naast de filmscène staat! Maak nu een kopie van die scène op de
tijdlijn. Als het goed is, dan staat de kopie nu achter de eerst filmscène. Studio plaatst de ko-
pie op de plek van de scrubber. Staat die dus per ongeluk ergens in de te kopiëren scène, dan
wordt het origineel overschreven. Dus is het zaak goed op te letten, waar je de scrubber
plaatst.
Sleep nu de kopie precies boven het tekstblok, dus in de derde tijdlijn. Selecteer de bovenste
filmscène en ga naar de Effecten Editor. Selecteer 2D-3D en daarna 2D Editor CPU. De scène
wordt nu met rand getoond: Standaard. In het uitrolmenu klik Je Geen Standaardwaarde aan.
Het beeld wordt nu beeldvullend en zonder rand.
Zorg dat de scrubber aan het begin van het filmbeeld staat. Klik nu op Het Keyframe Oranje
Ruitje bovenaan het uitrolmenu. Op de balk onder het scherm staat nu gelijk het eerste Key-
point.
Zet nu het Keypoint op het einde van de stippellijn. Ga nu naar Bijsnijden en bepaal van welke
kant de tekst zichtbaar moet worden: Boven, Onder, Links of Rechts. Voor dit voorbeeld kies
Ik Boven en ga schuiven met het balkje net zolang, totdat de tekst zichtbaar wordt. Het tweede
Keypoint wordt automatisch geplaatst. Klik op OK.
Maak eventueel een zachte overgang in het tekstframe.

In plaats van een tekst kan je deze procedure ook doen met een derde filmfragment. Dan moet
het filmbeeld met BIB en rand op de tijdlijn en op de goede plaats worden gezet.

EFFECTEN TOEPASSEN (PAGINAKRUL) Studio17+
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We slepen een videoscène op de tijdlijn. Zorg altijd dat de scrubber aan het begin van het
filmframe staat. Open de Effecten Editor. Selecteer nu 2D-3D. Selecteer vervolgens het effect
Pagina krullen. Er verschijnt rechts in beeld een instellingsscherm. De instelling staat als ge-
bruikelijk op Standaard. De keuzemogelijkheden zijn: Geen Waarde / Standaard / Breed af-
pellen / Smal afspelen / enz. Selecteer de regel Ombladeren. De Keyframes staan nu automa-
tisch onderin het scherm.
Het omkrullen van de pagina is instelbaar door het Keypoint te verplaatsen in de balk onder
het bewerkingsscherm. Het omkrullen begin dan pas op het Keypoint. In het andere geval be-
gint het omkrullen direct.

Eventueel kun je de achterkant een kleur geven. Daarvoor zet je een vinkje bij de regel ge-
bruik kleur. Klik met de muis in het zwarte kleurvlak. Selecteer in het kleurenscherm de kleur.
Klik daarna op toepassen. De achterkant van de clip krijgt nu de gekozen kleur.

Door telkens een ander frame in de aanloop van het zwarte gedeelte in het vorige frame te
plaatsen, kan je het zwarte gedeelde daardoor vervangen. Plaats frames boven en onder elkaar
en kien even uit, waar het volgende frame moet staan.
Tussen twee filmframes kan je ook eventueel een tekst zetten. Wel even kijken waar de tekst
moet beginnen.

HFX EFFECTEN Studio17+
We kennen deze effecten al vanuit Studio14. In de nieuwe programma’s is dit natuurlijk be-
hoorlijk uitgebreid.
Sleep een video op de tijdlijn en plaats een clip op het spoor daarboven. Klik daarna rechts in
de bovenste videoclip en selecteer in het uitrolmenu Effecten Editor openen. In Het Editor
Scherm gaan we naar tabblad Effecten/2D-3D en selecteren HFX filter. We klikken daarna
rechts bovenin het scherm op de knop Openen.
Nu start de HFX Editor op. Via dubbelklikken kun je een bepaald HFX Effect selecteren. Met
de play-knop kan je het effect afspelen. Je kunt eventueel de parameters in het linker scherm
veranderen. Daarna klikken we rechtsonder op OK en sluiten de HFX editor.

LOGO MAKEN Studio17+
We gaan een logo maken.
Klik de knop T bovenin de tijdlijn aan om een tekst te maken. Verwijder de automatisch ver-
schenen tekst in het Titelvenster met de muis of verwijder de volledige tekstlaag via Laag ver-
wijderen onderin het scherm met de muis. Het scherm is nu leeg.
Ga naar Vormgereedschap en klik op Vierkant toevoegen. Kies vervolgens Opvulling om een
kleur aan te maken. (Kleur toevoegen en bewerken kun je oude uitleg vinden.)
Naast het vormgereedschap vind je ABC. Door daarop te klikken verschijnt er een tekst. Ve-
rander deze tekst in bijvoorbeeld SGD. Tekst typen kan direct in het scherm, maar ook boven-
in het uitrolmenu. Geef de tekst een kleur en een gekleurde rand.
Plaats de tekst door te slepen in het vierkant. Door aan de omtreklijnen te trekken kun je de
tekst breder of hoger maken.
We gaan nu het vierkant en de tekst tot een geheel maken.
Selecteer zowel de tekst als de vorm door met de muis over allebei de onderdelen een recht-
hoek te slepen, of via de sneltoetsen CTRL A (Alles selecteren). De omtreklijnen geven aan,
dat beide items zijn geselecteerd. Via rechtsklikken kun je in het uitrolmenu Groeperen kie-
zen. Alles is nu een geheel. Door op dezelfde wijze voor Degroeperen te kiezen kun je de on-
derdelen opnieuw apart bewerken.
Maak nu een of meerdere balken met het vormgereedschap in kleur en zet het logo er voor.
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Ook nu kun je alles ook weer Groeperen. Met de functie Rangschikken kan je bepaalde vor-
men naar voren of naar achteren plaatsen.
Als je een vorm of groep heb gemaakt en je bent tevreden over je logo, ga dan naar Effecten >
2D3D > Bib > Geen Standaardwaarde. Afhankelijk van hoe en waar je het log wilt gaan ge-
bruiken kun je het formaat aanpassen. Wil je een klein logo, wat meestal het geval zal zijn, zet
de waarde dan bijvoorbeeld op 50.
Via Keyframes kun je het logo langzaam laten inzoomen of uitzoomen. Plaats hierbij de
scrubber aan het begin van het frame en zet het aan. Een klein vierkantje verschijnt op de lijn,
dat is je eerste keyframe. Verplaats de scrubber naar de plek, waarbij je het logo vergroot wil
zien. Maak het logo op maat, bijvoorbeeld 100. Automatisch wordt het tweede keyframe
aangemaakt. 
Wil je het logo van links naar rechts laten lopen, dan kun je op dezelfde wijze ook dat realise-
ren. Misschien wil je zelfs een ingewikkelde beweging over het scherm laten komen, waarbij
het formaat varieert. het kan allemaal, als je maar voldoende keyframes aan maakt.

TEKST MET 2 KLEUREN VERLOOPACHTERGROND Studio17+
Om een tekstvak of een vorm te maken met een verloop van twee kleuren, kunnen we de
Tekst Editor goed gebruiken. Klik op de knop T (titel maken) en verwijder de tekst, die in het
venster staat. Je kunt dit doen door selecteren van het tekstblok of door met de rechtermuis-
knop op laag te klikken en vervolgens laag verwijderen.
Ga eerst naar de knop Vormgereedschap links bovenin de tijdlijn. Hier selecteren we een
vorm. We klikken hierop en de vorm staat in het scherm. We kunnen deze rechthoek zo hoog
en breed maken als wij willen en er kan later een tekst in geplaatst worden.
Open nu in het rechterscherm de instelling Opvullingen en klik op het Witte Vulvlak. Het kleu-
renscherm verschijnt.  Klik op de Meerkleurenknop links onder het kleurenscherm. Er ver-
schijnt nu een kleurenbalkje extra met links en rechts twee kleine vierkantjes. 
Selecteer in de Meerkleurenvoorbeeldbalk de linkse knop en selecteer een kleur. In mijn voor-
beeld is dat blauw. Klik op Toepassen.
Selecteer nu de rechtse knop. Herhaal de bovenstaande handelingen, maar kies een rode kleur.
Nu zien we twee vloeiend in elkaar overlopende kleuren.
Wil je een scherpere scheidslijn tussen de twee kleuren, schuif dan de twee knoppen dichter
naar elkaar en activeer via Toepassen.
Voor ons voorbeeld gaan we nog even Horizontaal instellen met de Rotatieknop. Klik op Toe-
passen en deze vorm is klaar.

De vorm is altijd achteraf nog in te stellen. Als je een rechthoek hebt gemaakt, dan kun je een
tekst er inschuiven. Maak de balk extra lang, zodat we ook een lange tekst kunnen maken.
Daarna kun je de gekleurde balk bijsnijden.
Plaats eventueel nog een foto vooraan op de balk. Dit doe je als volgt.
Ga weer naar het Vormgereedschap en selecteer een vierkant. Sleep een foto naar het vierkant.
Het vierkant is nu gevuld met de foto. Dit kan overigens ook een bewegend filmbeeld zijn.
Alles selecteren door slepen met de muis over de diverse vakken heen of sneltoets CTRL A
(alles selecteren). Rechtsklikken en kies groeperen. Het is nu een geheel en het kan niet meer
los van elkaar vershuiven. Klik op OK.
Als je een specifieke kleur wilt hebben, zoals goud of zilver, dan kun je gebruik maken van
het pipet in het kleurenvak. Zoek via google iets met de bedoelde kleur of kijk in je biblio-
theek of er een foto of film zit met de bedoelde kleur. Ga er met het pipet opstaan om de kleur
te selecteren. Een tip:

Twee schermen tegelijk gebruiken Computer
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Minimaliseer de foto en minimaliseer ook het Studioscherm. Je heb dan twee programma’s in
een scherm en je kunt schakelen van scherm naar scherm.

Maak een vorm, ga naar opvulling, klik het pipet aan en ga naar het andere scherm. Klik daar-
in op de beoogde kleur in de foto. In het kleurenscherm wordt dan de nieuwe kleur aangege-
ven. Klik OK.

GREENSCREEN FOTO’S IN EEN MONTAGEPROGRAMMA Studio

Dionne Stax voor gebr. de Witt
Nodig: 1 basisfoto (Gebr. de Witt) en 1 foto (Dionne gemaakt met Greenscreen).
Plaats de basisfoto (De Witt) op de tijdlijn. Meestal is spoor 2 geselecteerd. De foto staat
meestal klein/kort op de tijdlijn, dus je kan de tijdlijn uitzoomen/uitrekken, zodat je iets meer
overzicht hebt. Selecteer nu spoor 1, spoor wordt grijs.
Zoek en selecteert de foto (Dione), die je heb gemaakt met greenscreen uit de bibliotheek.
Plaats deze foto (Dione) op spoor 1 en maak die even lang als de afbeelding op spoor 2. Klik
met de rechtermuisknop op de foto in spoor 1 en open EFFECTEN EDITOR. Klik KEYERS >
STUDIOCHROME aan, het groene gedeelte verdwijnt en de foto komt nu bovenop de foto in
spoor 2. OK.
Selecteer weer de bovenste foto (Dione) en ga nu weer naar de EFFECTEN EDITOR. Ga naar
2D-3D > 2D EDITOR CPU en klik die aan. In het uitklapscherm staat er automatisch, Instel-
ling. Selecteer Standaard. Er verschijnt nu een kleurenkader in het beeld. Bij Standaard staat
een pijltje en als je hierop klikt, dan kan je Geen Standaardwaarde selecteren. Het kader verd-
wijnt en de foto staat in beeld. Mochten er aan de zijkanten van de bovenste foto witte strepen
staan, dan kan je die wegwerken met BIJSNIJDEN LINKS en RECHTS.
Ga nu naar GROOTTE en klik op het slotje. Het slotje wordt nu ORANJE en als je gaat ver-
kleinen of vergroten blijft de verhouding hetzelfde. Ga nu de foto verkleinen of vergrootten en
zet de foto op de goede plaats. Ga nu naar POSITIE Y en schuif de foto (Dione) naar onderen
buiten beeld met POSITIE Y (Y is Verticaal). Zet de scrubber helemaal naar links. Klik nu op
het Keyframe ruitje boven in het uitrolscherm. Ruitje wordt oranje. Automatisch staat het eer-
ste Keypoint op de lijn. Zet nu de scrubber helemaal naar rechts. Ga nu weer naar de POSITIE
X en schuif Dionne op de goede plaats in het beeld. OK.
De snelheid van de beweging hangt af van de lengte van de frames.

Vliegtuig vliegt door wolken
Nodig: 1 basisfoto (wolken) en 1 foto (vliegtuig zoals hierboven gemaakt met Greenscreen).
Plaats de basisfoto op de tijdlijn. Meestal is spoor 2 geselecteerd. De foto staat meestal klein
op de tijdlijn dus je kan de tijdlijn uitzoomen/uitrekken, zodat je iets meer overzicht hebt. Se-
lecteer nu spoor 1, spoor wordt grijs. Zoek en selecteer de foto, die je heb gemaakt met green-
screen uit de bibliotheek. Plaats deze foto op spoor 1 en maak die even groot als de afbeelding
op spoor 2. Klik met de rechtermuisknop op de foto in spoor 1 en open de EFFECTEN EDI-
TOR. Klik KEYERS > STUDIOCHROME aan. Het groene gedeelte verdwijnt en de foto komt
nu bovenop de foto in spoor 2. OK. Selecteer weer de bovenste foto en ga nu weer naar de
EFFECTEN EDITOR. Ga naar 2D-3D > 2D EDITOR CPU en klik die aan. In het uitklap-
scherm staat er Automatisch. Selecteer bij Instelling Standaard. Er verschijnt nu een kleuren-
kader in het beeld. Bij Standaard staat een pijltje en als je hierop klikt dan kan je Geen Stan-
daardwaarde selecteren. Het kader verdwijnt en de foto staat in beeld. Mochten er aan de zij-
kanten van de bovenste foto witte strepen staan dan kan je die wegwerken met BIJSNIJDEN
LINKS en RECHTS.
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Ga nu naar GROOTTE en klik op het slotje. Het slotje wordt nu ORANJE en als je gaat ver-
kleinen of vergroten blijft de verhouding hetzelfde. Ga nu de foto verkleinen of vergrootten.
Ga nu naar POSITIE X en zet de foto ( vliegtuig) buiten beeld met POSITIE X  (X is Horizon-
taal). Zet de scrubber helemaal naar links. Klik nu op het Keyframe ruitje boven in het uitrol-
scherm. Ruitje wordt oranje. Automatisch staat het eerste Keypoint op de lijn. Zet nu de
scrubber helemaal naar rechts. Ga nu weer naar de POSITIE X en schuif het vliegtuig hele-
maal links uit het beeld. OK.
De snelheid van het vliegtuig hangt af van de lengte van de frames. Hoe langer de frames des
te langzamer vliegt het vliegtuig.

Noot: zie ook Afbeelding uitsnijden voor gebruik met green screen in het hoofdstuk Photo-
shop.

CARTOON VERWERKT IN EEN FOTO Studio
Zoek in Google > Cartoon/wandelen/Afbeelding en zoek ook een foto van een bos. Let op de
het bestandsformaat, zoals al een keer is uitgelegd. Sla op in een mapje.
Bewerk in Photoshop. Zie bij dat hoofdstuk.

Open na de bewerkte afbeelding opgeslagen te hebben het montageprogramma.
Begin altijd met een filmzwartje. Zet de foto van het bos op de tijdlijn en maak de lengte on-
geveer 10 sec. Kies Selecteren > Schalen >Vullen, als er zwarte balken aan de zijkant zijn. De
foto wordt een klein beetje uitvergroot of met de Effecten Editor > 2D-3D > Standaardwaar-
de wordt Geen Standaardwaarde en Grootte en Breedte aangepast (bij het oranje slotje). Hier-
door heb je geen pixelverlies.
De eventuele zwarte randen zijn nu verdwenen.

Zet nu de cartoon boven het frame van het bos en maak die even groot als het onderste frame.
Ga nu naar de Editor > Keyers > Studiochroom en het groen is verdwenen. Ga nu naar 2D-3D
> 2DCPU > Standaard > Geen Standaard. Maak de cartoon kleiner met H/G en zet de car-
toon onderaan het scherm Met Positie Y, eventueel met de pijltjestoetsen. Zet de scrubber he-
lemaal links in het frame. Schuif de cartoon met Positie X links net niet buiten beeld. Activeer
het Keyframe-ruitje bij Positie X. Zet nu de scrubber een eindje naar rechts, ongeveer ¾ in het
frame. Daar komt later het tweede Keypoint. Schuif nu met Positie X de cartoon naar rechts
tot bijna op het einde. Het tweede Keypoint staat er automatisch. De wandelaar loopt nu van
links naar rechts.

Selecteer de 3e tijdlijn of voeg die er bij.
Zet de scrubber tijdelijk rechts aan het einde van de frames. Ga naar T en maak bij voorbeeld
de tekst Wandelen op de Veluwe. Maak de tekst eventueel kleiner, geef de tekst een kleur en
eventueel een ander lettertype. Zet de tekst linksonder in het scherm. De tekst is later nog aan
te passen. OK.
Zet nu het Tekstframe boven de andere frames en maak die even lang. Zet de scrubber hele-
maal links in het frame. Selecteer het Tekstframe en ga naar  2D-3D > 2D CPU > Standaard
> Geen Standaard. Schuif met Positie X de Tekst naar links, uit het beeld.
Activeer het Keyframepoint bij Positie X. Zet nu de scrubber een stukje voorbij het midden,
ongeveer waar de cartoon stilstaat. Schuif met Positie X de tekst achter de wandelaar. Het
tweede Keyframe is automatisch gezet.
Effect: de wandelaar loopt van links naar rechts en de tekst komt er achteraan.
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In plaats van een achtergrondfoto (bos) kan je ook een filmpje gebruiken. maar ik vind het dan
erg onrustig worden. Het filmpje moet wel de goede lengte hebben, want je bent dan gebon-
den aan die lengte van de film. Bij gebruik van een foto kan je deze intro net zo lang maken
als je wilt, maar als de frames langer worden gaat het Effect langzamer.

Landgedeelte uitlichten
Zoek een afbeelding van een land in Google met egale kleurvakken. Dit is makkelijker om te
selecteren. Bewerk weer in Photoshop. Zie aldaar.

In het montageprogramma Studio
Uitsnede en originele afbeelding importeren in Studio. Zet een afbeelding van een landgedeel-
te op de tijdlijn en maak die ongeveer 10 sec. lang. Tijdlijn uitzoomen/Uittrekken. Eventueel
Schalen > Vullen of via het Tekstmenu. Bij Tekstmenu: zet de scrubber rechts van het frame.
Klik op ( T ) Tekst maken. Laag verwijderen. OK.
Zet nu het lege tekstframe onder het eerste frame en maak die even lang. Ga weer naar  Be-
werken Titel en naar Achtergrond Instelling. Klik op Dropzone en daarna op het Pipetje. Ga
met het Pipetje naar de achtergrondkleur van de afbeelding en kies daarna Toepassen. OK.
Het hele vlak heeft nu dezelfde kleur en de afbeelding is hetzelfde gebleven.
Zet nu de uitgeknipte afbeelding boven het eerste frame. Ga naar de Editor > Effect > Keyers
> Studiochroom.
Ga nu naar 2D-3D > 2D CPU > Standaard en verander in Geen Standaard. Zet nu Met Posi-
tie X, Y en Grootte de afbeelding op de goede plaats. Eventueel met de pijltjestoetsen de af-
beelding op de goede plaats zetten. Activeer het Keyframepoint Bij Positie X en Y. Zet nu de
scrubber ongeveer ¾ in het frame. Schakel bij Positie X/Y en Breedte / Hoogte De Keyframe-
ruitjes in. Zet nu de scrubber naar het midden van het frame. Ga naar Grootte en zet met
Hoogte en Breedte de afbeelding in het midden van het frame. Er staan nu automatisch Key-
framepunten in het scherm. Bij het afspelen van het frame gaat het uitgesneden frame van
klein naar groot.

Eventueel kan je er nu nog een tekst boven zetten en in het goede gedeelte plaatsen. Wel even-
tueel een Spoor Track boven invoegen. Zet even de scrubber aan de rechtse kant van de fra-
mes. Ga naar (T) Tekst en maak er een tekst van. In ons voorbeeld is dat Zuid Holland. Letter-
type, Grootte en Kleur eventueel aanpassen. OK.

Zet nu het tekstframe boven de andere frames. Ga weer naar 2D-3D > 2D CPU > Geen
Standaardwaarde. Zet nu met Positie X/Y en Grootte de afbeelding op de goede plaats. OK. 
Maak het tekstframe korter, zover dat de uitsnede op zijn grootst is.

FOTO’S MET ZWARTE ZIJBALKEN BEWERKEN IN DE TIJDLIJN Studio
Zet de foto op de tijdlijn. Zijn de zwarte balken aan de zijkant maar heel smal, dan kan je ze
wel wegwerken. Selecteer de foto. Ga via Schalen naar Uitvullen. De foto wordt wel iets gro-
ter en breder. Let op of de verhoudingen nog wel kloppen.
Andere manier is, vooral bij foto’s die verticaal staan: zet de foto op de tijdlijn op een bepaal-
de lengte. Zet de scrubber naast de foto. Ga nu naar het tekst invoegen (T). Verwijder de
vormlaag. OK.
Zet nu het lege tekstvlak onder de foto. Maak het lege tekstvlak even groot als de afbeelding.
Klik er weer in het tekstvlak op Bewerken Titel. Ga nu naar Achtergrond Instellingen. Klik in
de Achtergrond Dropzone. Ga met het pipetje naar het kleurenvlak en kies een kleur uit de
foto voor de achtergrond. Kies een kleur, die het meeste bij de afbeelding past. Links of 
rechts. Het hele kleurenvlak heeft nu als achtergrond dezelfde kleur.
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Heb je een afbeelding met aan beide zijde een andere kleur, maak dan een kopie van het eerste
kleurvlak. Zet die onder elkaar. Verander de kleur van de andere zijde van de foto. Links of
rechts. Je ziet nog geen verschil.
Selecteer het bovenste kleurvlak en ga naar Effecten 2D 3D > 2D. Geen standaardwaarde. Bij-
snijden links of rechts. Als je één van de vlakken hebt bijgesneden, hoef je andere vlak niet bij
te snijden, want dat staat al automatisch goed in beeld. Je kunt ook met 2D procedure de foto
opschuiven met Positie bv. helemaal naar rechts. Ga met de muis over al de vakken, zodat ze
zijn geselecteerd. Rechts klikken. Ga naar Groeperen > groeperen. Nu kan je het hele blok
verplaatsen.

GEKLEURDE BALKEN VOOR TEKSTONDERSCHRIFT Studio
Als voorbeeld: Computerclub SGD Ledenavond. Nodig: Foto of film van de SGD. Bij film
wordt het iets onrustiger, omdat je diverse bewegingen en effecten in het beeld krijgt.
Zet een zwartje (Zwart filmfragment) op de tijdlijn. Meestal is spoor 2 geselecteerd (licht-
grijs). Klik de T aan en het Titelvenster staat in het scherm. Verwijder met de muis de tekst-
laag (Uw Tekst Hier) onder het scherm, zodat het scherm leeg is. Links klikken en daarna
Laag verwijderen.
Met de map vormgereedschap, links naast ABC, plaatsen wij een rechthoek. Maak van de
rechthoek een smalle balk met een bepaalde breedte in het scherm door links en rechts de balk
uit te trekken. Bepaal  de hoogte van de balk. Met Vullen er een kleur aan geven, bv. de SGD
kleur GEEL. Je krijgt dus een geel horizontaal balkje in het scherm. Later kan je er nog even-
tueel een zwarte rand om zetten en kunnen wij de plaats nog corrigeren. OK.
Selecteer nu het Tekstscherm. Ga naar Effecten Editor 2D-3D en dan 2D editor CPU. Ga van
standaardwaarde naar ‘geen standaardwaarde’. Zet de cursor helemaal naar links. Zet met Po-
sitie X de balk helemaal links net uit het beeld. Klik nu op het ruitje van de Keyframing en het
eerste Keypoint staat op de lijn. Zet nu de scrubber helemaal naar rechts. Zet met Positie X de
balk ergens in het beeld. Tweede Keypoint is automatisch gemaakt. De balk loopt nu van links
naar ergens rechts. OK.
Zet de scrubber even naast de frames. Maak een kopie van het tekstframes en plak die dus
even naast de frames. Je heb nu alles gekopieerd dus ook het effect. Zet nu het gekopieerde
frame boven het andere frame. Je heb nu twee dezelfde frames met balkjes en als je het af-
speelt zie je maar één balkje, maar het zijn er twee. Klik het bovenste frame aan en ga naar
Bewerken Titel om de tweede balk op de goede plaats te gaan zetten. Omdat er een effect is
aangebracht moet de scrubber even aan het einde van het frame zetten, zodat het balkje hele-
maal in beeld is. Selecteer nu het balkje en verander de positie met de muis en de kleur. OK
Omdat je een kopie gemaakt hebt van het eerste frame lopen de balkjes gelijk op.
Maak het bovenste frame iets korter, het onderste balkje komt dan later in beeld. De lengte
van de frames bepaalt de snelheid, waarmee de balken in beeld komen. OK.
Zet nu de scrubber helemaal naar rechts over beide frames, zodat beide balkjes helemaal in
beeld staan aan het einde. Maak een Snapshot en zet die naast de frames op de tijdlijn. De bal-
ken blijven nu in het beeld staan en dit frame kan je zo net zo lang maken als je wilt maar de
balkjes bewegen niet meer. OK.
Zet de scrubber weer naast de frames. Selecteer ( T ) en maak met Bewerken Titel de tekst
‘Computerclub SGD’. OK.
Zet nu dit tekstframe boven het laatste frame. Selecteer het tekstframe en ga naar Bewerken
Titel. Zet nu de tekst in de bovenste balk. Pas de grootte en de kleur aan, zodat het in het balk-
je past. Klik nu link, naast het vormgereedschap, op ABC. Dit betekent Tekst toevoegen.
Type nu in dit venster ‘Ledenavond’ en zet dit in de onderste balk. Eventueel kleur en grootte
aanpassen. OK.
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Maak nu het tekstframe links een beetje korter zodat de tekst iets later in beeld komt. Eventu-
eel met een zachte overgang. Deze laatste twee frames kan je net zolang maken als nodig is
voor je film.

OUDE AVI-FILMS IMPORTEREN LUKT NIET Studio 19
Vraag: Ik heb een aantal oude films gekregen om te gebruiken in een compilatie voor en fami-
liegebeuren. De films worden niet geopend/geaccepteerd in Studio 19. Als ik ze in een wille-
keurige mediaplayer opent, dan werkt het wel.
Antwoord: Ter plekke geprobeerd. Duidelijk is dat de nieuwste versies van Studio oudere be-
standen, zoals avi’s niet meer binnen kan halen. Een oude truc door avi in mpg te veranderen,
werkt ook niet. De enige mogelijkheid is dus om de films te converteren naar bv. mp4. Dit is
in de pauze even gedaan.

VIDEOFILM OF AFBEELDING IN DIVERSE VORMEN Studio17+
Klik de T aan om een tekst te maken. Verwijder de bestaande tekst met de muis of verwijder
de tekstlaag via laag verwijderen onder het scherm met de muis. Het scherm is nu leeg.
Ga naar het vormgereedschap en klik op vierkant toevoegen. Bepaal de afmeting, zoals eerder
beschreven. De vorm blijft wit. Plaats het vierkant, waar je het wilt hebben.
Herhaal dit een paar maal, maar dan wel met andere vormen en maak een compositie van deze
vormen.
Sleep uit de bibliotheek een film of een foto naar een vorm en herhaal dit tot alle vormen zijn
gevuld. Als er vormen over elkaar heen staan en/of je wilt een andere volgorde hebben, ga dan
naar Rangschikken en bepaal welke vorm er voor of achter moet staan. De vormen zijn achter-
af nog op een andere plaats te zetten, als je niet tevreden bent. Het is een kwestie van een
vorm te selecteren en vervolgens te wijzigen en/of verplaatsen.
Als alle vormen gereed zijn zit je nog wel met een zwarte achtergrond. Om een achtergrond te
krijgen kan je in het uitrolmenu via Achtergrond Instellingen een kleur, een afbeelding of een
foto slepen naar de Dropzone in het uitrolmenu.
Wil je er ook nog een tekst in plaatsen, klik dan op ABC. Er verschijnt een tekst, die je kunt
bewerken.
Als je gebruik hebt gemaakt van films, dan kan je niet bepalen welk stukje er uit de film te
zien is. Het eerste beeld van de film uit de Bibliotheek komt in de vorm. Wel kun je eventueel
een snapshot maken, als je een bepaalde scène uit een film wilt gebruiken en die als afbeel-
ding weer in een vorm plaatsen.

TEKSTEN OP DEZELFDE PLAATS HOUDEN BIJ ONDERTITELING Studio17+
Om teksten steeds op dezelfde plaats te houden, omdat de teksten steeds van lengte verande-
ren, kunnen we de volgende methode toepassen.
Plaats een video op de tijdlijn en selecteer daarna het spoor boven deze videoclips. Klik op de
knop T (tekst invoegen). De Teksteditor start. Stel het lettertype en de grootte in. Typ de tekst.
Klik ik op de knop Groep uitlijnen (te vinden naast ABC boven de tekstlaag). In het uitrolme-
nu kies je als uitlijning voor linksonder, midden of rechts, enz. De tekst verplaatst zich nu
volgens de aangegeven uitlijning, exact op de rasterlijnen van de Editor. Klik OK en we zijn
weer op de tijdlijn.
Selecteer nu het tekstvak op de tijdlijn, kopieer die (CTRL C). Plaats de scrubber naast het
eerste tekstvak. Kies nu plakken (CTRL V). We zien nu een nieuw tekstvak naast het oude
tekstvak met dezelfde tekst. Klik rechts in dit vak en selecteer Bewerken titel. Wijzig de tekst
en selecteer opnieuw de knop Groep uitlijnen en klik dezelfde positie aan.
Door weer opnieuw te kopiëren en te plakken kun je zo de hele video afwerken.
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TEKSTBALLON MAKEN Studio
Vraag: Ik zou graag willen weten hoe je zo'n tekstballonnetje maakt zoals in stripboeken. In
studio 14 heb ik wel een vierkant lijstje gevonden, maar geen ovaaltje met een punt naar bene-
den. En in 22 eigenlijk niets.
Antwoord: In Studio 15 zit wel een wolk, die je er voor kunt gebruiken. Werk via Tekst ma-
ken door te dubbelklikken op het Tekstspoor en vervolgens Vormen
en Wolk aan te klikken.
Je kunt ook in Google een Tekstballon zoeken. Ga naar Google en
zoek Tekstballon Greenscreen. Je kunt dan kiezen uit verschillende
soorten tekstballonnen met een groene achtergrond.
Vervolgens klik je een afbeelding aan en plaatst het via Kopiëren
en Plakken in je map of Bureaublad. Geef de afbeelding wel een naam, want als je de afbeel-
ding plakt, dan staat er een nummer onder.
In alle Studioprogramma’s kan je dan met Keyen de groene achtergrond weghalen.

Monteren in Studio 21 enz.
Importeer de greenscreen tekstballonnen naar de bibliotheek. Zet de foto of film op een tijd-
lijn. Niet vergeten om altijd met een zwartje te beginnen. Zet nu de afbeelding van de Tekst-
ballon boven de foto/film en maak die even lang. Ga naar Effecten > Keyers > StudioChroma-
Keyer en klik aan.
Ga naar de Editor > 2D-3D > 2D CPU > Standaardwaarde en selecteer Geen Standaard-
waarde. Met Positie X/Y en Grootte zet je de Tekstballon op de goede plaats. Boven het
Tekstballonframe zet je een tekst, die je aangepast hebt en plaatst het in de Tekstballon.
CLIP ACHTERSTEVOREN LATEN LOPEN
Vraag: In Studio 22 weet ik niet hoe je een opname achterstevoren kunt laten lopen. (weet ik
wel in 14).
Antwoord: Studio 15
Plaats de film op de tijdlijn. Open de Gereedschapskist. Klik Video-Effecten aan. In het uit-
klapmenu, waar je de snelheid kan regelen, moet je Video Omgekeerd aanvinken.

Studio 16 tot 22
Selecteer de film op de tijdlijn en kies Snelheid > Toevoegen. Je kunt nu de snelheid aanpas-
sen. Bij Video het vakje Omgekeerd aanvinken.

Studio 21 enz.
Film selecteren. Ga naar in de regel bij Eigenschappen naar Tijd Remapping. Daar kan je de
snelheid regelen en ook de film omkeren.Met de gele horizontale lijn kan je de snelheid mee
veranderen. Bij Video het vakje Omkeren aanvinken.
Je kunt ook eventueel zelf een tekstvak maken. Maak een (T) tekstvak en verwijder de vorm-
laag. Ga naar vormgereedschappen en selecteer een Horizontale Pil. Selecteer ook een drie-
hoek, maak die kleiner en pad de driehoek met rotatie zo, dat er een klein puntje onder de pil
laag komt. Selecteer de twee vormenlagen en Groepeer via Rechtsklikken > Groeperen. OK.
Ga naar 2D-3D > 2D CPU, verklein het tekstvak en zet het vak op de goede plaats. Zet hier
weer een normaal Tekstvak boven en zet de tekst aangepast in het tekstvak.
Als je het tekstvlak een andere kleur wil geven, ga dan weer naar Bewerken Titel en selecteer
een kleur  mett de vulkleur. Dit moet wel in de vormlagen zelf worden veranderd. Het werkt
niet als groep.

SNELHEID WIJZIGEN - VIDEO OMKEREN Studio
De snelheid van een clip wijzigen. Langzamer of sneller.
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Selecteer de clip, waarvan de afspeeltijd gewijzigd moet worden. Dubbelklik daarna in de clip
of selecteer de Editor. In de Editor selecteren we in de tabbladregel Time Remapping. Je krijgt
dan een apart uitklapmenu.
Als je een bepaald beeld hebt geselecteerd in de tijdlijn, klik je in het Uitvouwmenu Huidige
Frame aan. Rechts in het menu kan je met de gele horizontale lijn of met het oranje schuifje
de snelheid gaan bepalen. Gebruik de gele lijn, als je de snelheid wilt gaan aanpassen en ook
met Keyframes wilt gaan werken. Zo kun je in een frame verschillende snelheden gaan toepas-
sen (als je computer dit aan kan).
Tip: ga niet van 100% gelijk naar 500%, want dan loopt bij mij de computer steeds vast. Het
duurt wel even voor de snelheid is aangepast (gerendeerd). In dit uitvouwmenu kan je het fra-
me ook Omkeren door het aan te vinken.
In de tijdlijn ontstaat nu een roze stuk wat alleen maar het laatste stilstaande beeld weergeeft.
Knip en verwijder dat stuk. Als je het frame langzamer hebt gemaakt, dan kun je het frame op
de tijdlijn uittrekken.
Let wel op, dat het eventuele geluid ook meegaat in de snelheid!
Zet het geluid uit of selecteer het frame en ga het geluid loskoppelen van het beeld. Klik op
het frame en in het uitvouwmenu Audio Loskoppelen.
Houd er rekening mee, dat als je gaat loskoppelen er een tijdlijn bij komt en tijdlijnen, die er
eventueel onderstaan een regel zakken.

FOTO OPKOMENDE ZON / TEKST Studio
Nodig:  Foto van een zee met een horizonlijn.

Google
Zoek in Google de  horizonlijn met een zee en deze opslaan in een mapje. Foto eventueel be-
werken met Photoshop voor de goede maat. (16:9).

Montageprogramma
Importeer de foto in de bibliotheek. Zet de foto op SPOOR 2 in de tijdlijn. Waarschijnlijk zie
je zwarte balken aan de zijkant. Vullen of met 2D - 3D uitvergroten. Maak de lengte ongeveer
20 seconde. Later kan dit nog langer of korter worden. Zet de scrubber even naast het frame
en ga naar (T) Titel maken. Verwijder de laag “Uw Tekst Hier”. Klik op de TEKSTLAAG >
LAAG VERWIJDEREN. Je heb dan een leeg scherm. OK. Zet nu het lege frame op SPOOR 1,
dus boven de foto. Maak ook het lege (T) scherm even lang als de foto van de zee.
Selecteer weer het tekstframe en ga naar BEWERKEN TITEL. Ga naar VORMGEREED-
SCHAPPEN en selecteer een CIRKEL. Ga naar OPVULLING en klik op het witte vlakje voor
kleuren en klik onder het kleurenvenster het rechtse vakje aan voor kleurenverloop. Geef de
cirkel een oranje/rode kleur en zet met het kleine ronde schijfje de lichte kleur boven. Met het
andere kleine vakje kan je het verloop bepalen. Maak de cirkel kleiner. De positie is even niet
belangrijk. Ga naar VERVAGEN en zet de schuif op ong-
eveer 60 en de DEKKING op 50. Je ziet nu een zon mid-
den in het beeld. OK.
Voeg een extra spoor boven. Spoor toevoegen: boven
track.
Maak een kopie van de eerste foto en plaats die twee tijd-
lijnen boven het eerste frame. Zo weet je zeker dat je twee
dezelfde frames heb. De frames op de andere tijdlijn zie je
even niet.
Selecteer de bovenste foto en ga naar de EDITOR > EF-
FECTEN > BEWERKEN > 2D EDITOR- CPU> Geen Standaardwaarde. Scrol in dit scherm
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naar beneden naar BIJSNIJDEN > BOVEN. Ga met de schuif naar rechts, zover dat je precies
op de horizonlijn uit komt. Of je goed zit, zie je aan de zon.
Selecteer het tekstscherm met de zon. Ga naar Editor > 2D-3D > 2D Standaardwaarde > 
Geen Standaardwaarde. Zet de scrubber links in het frame. Zet met POSITIE Y de zon naar
beneden zover dat je de zon net niet meer ziet. Activeer het Keypoint bij POSITIE Y. Zet nu
de scrubber ¾ in het tekstframe. Zet met POSITIE Y de zon weer net boven de horizonlijn.
Het tweede Keyframe staat er automatisch. Ok.
De zon komt nu op aan de horizon. De lengte van de frame bepalen de snelheid van de opko-
mende zon.
Wil je er een wolkenpartij of tekst in zetten, dan moet je het bovenste frame één spoor hoger
zetten. En dan de zelfde procedure volgen als de opkomende zon. Tekst kan je gewoon maken

met een tekstframe, maar de voor wolken moet je de
Greenscreen wolkenfoto gebruiken.
Selecteer het tekstscherm met de tekst. Ga naar Editor >
2D-3D > 2D Standaardwaarde > Geen Standaardwaar-
de. Zet de scrubber links in het frame. Zet met POSITIE
Y de Tekst naar beneden zover dat je de tekst net niet
meer ziet. Activeer het Keypoint bij POSITIE Y. Zet nu
de scrubber ¾ in het tekstframe. Zet met POSITIE Y de
tekst weer net boven de horizonlijn. Het tweede Keyfra-

me staat er automatisch. Ok. De tekst komt nu op aan de horizon. De lengte van de frame be-
paald de snelheid van de opkomende zon. Bij een wolkenfoto kan je kiezen voor stilstaande
wolken of wolkenfoto die je laat verschuiven.
Deze bewerking is vorige keer al uitgelegd.

VLIEGTUIG ROUTE MET STIPPELLIJN OF RODE STREEP Photoshop en Studio
Eenvoudige uitvoering.
Zoek in Google een landkaart van de wereld of een bepaald land. Opslaan in het goede mapje.
Bewerk de afbeelding in Photoshop. Zie hiervoor het hoofdstuk Photoshop.

In Montageprogramma
Begin met een zwartje. Zet de kaart met de stippellijn op het spoor in de tijdlijn.
Spoor 2.
Zet nu de originele kaart er boven. Spoor 1. Trek de foto’s op de tijdlijn uit naar ongeveer 8
sec. en zoom de tijdlijn uit om makkelijker te werken. Zet de cursor helemaal links in het fra-
me. Selecteer de lege wereldkaart in Spoor 1 en ga naar 2D-3D Editor > 2D CPU > Geen
Standaardwaarde. Ga naar BIJSNIJDEN RECHTS, snijd rechts het frame bij tot net voor de
stippellijn begint en activeer de Keyframe bij rechts. Zet nu de scrubber helemaal rechts.
Bij BIJSNIJDEN de schuif naar rechts schuiven totdat de hele lijn zichtbaar is. Doordat de
wereldkaart met stippellijn is bewerkt kan de foto met stippel iets donkerder geworden zijn. 

Met Effecten > Camera > Belichting > Helderheid kan je
de wereldkaart met stippellijn gelijk van helderheid krij-
gen. 
Zet de scrubber even in het midden zodat je het verschil
kan zien tussen licht en donkerder.
Wil je een ROUTE maken maar dan de andere kant op,
moet je in plaats van rechts bijsnijden nu Links bijsnijden.
Uiteraard moet je dan met Photoshop weer een nieuwe
vluchtroute maken.

In plaats van een stippellijn kan je natuurlijk ook een gekleurde lijn maken.
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Een route maken met stippen, die alle kanten uit kunnen met je met vormgereedschap > Cir-
kel. Via 2D-3D enz. zet je de stip op de goede plaats. Maak van dit frame een kopie en zet de
boven de eerste stip. Met Effecten 2D-3D zet je de tweede stip naast de eerste stip.
Herhaal deze bewerking net zo lang als nodig is. Voor deze bewerking heb je wel erg veel
tijdlijnen nodig.

In de eerdere avonden is al uitgelegd om een vliegtuig te maken met Greenscreen.

Maak een extra tijdlijn boven Spoor 1. (Boven Track ).
Zet dit frame met het greenscreen vliegtuig in de tijdlijn bovenop de andere frames. Ga naar
Editor > KEYERS > StudioChroom.
Ga naar Effecten > 2D-3D > 2D CPU > Standaardwaarde > Geen standaardwaarde.
In 2D-3D kan je met SPIEGELING > Flip Horizontaal het vliegtuig de goede kant op zetten.
Met GROOTTE en POSITIE X/Y de goede maat van het vliegtuig bepalen. B.v. Grootte 25.
Zet het vliegtuig op het beginpunt en KEYFRAMING activeren. De scrubber links.
Keyframe aanvinken bij POSITIES X/Y. Schuif nu de cursor een klein beetje
naar rechts tot de eerste stippels in beeld komen. Ga nu met POSITIE X het
vliegtuig de lijn volgen met Positie X. Meestal is het beste om het met de
pijltjestoetsen te doen, want soms is het millimeterwerk.
Gebruik hiervoor de pijltjestoetsen links of rechts.
Het schuifje bij Positie moet oranje zijn gekleurd om het met
de toetsen te verplaatsen. Schuif nu de cursor een klein beetje
naar rechts tot de volgende stippels in beeld komen. Stip voor stip
en telkens na een paar stippen een Keypoint zetten. Dus telkens de
scrubber een klein beetje naar rechtsschuiven. Van begin tot het eindpunt
heb je dus heel veel KEYPOINTS.
In ons voorbeeld hebben wij een vliegtuig genomen die wij links of rechts kun-
nen laten vliegen. Wil je route maken die naar beneden of boven loopt moet je een afbeelding
zoeken van een vliegtuig die je van bovenaf ziet.

STABILISEREN Studio
Om een onstabiel beeld te corrigeren gebruiken we de functie Stabilisatie.
Selecteer de videoclip, die je wilt stabiliseren. Selecteer dan rechtsboven de Editor. Ga naar
Media Editor / Stabiliseren. Nu kunnen we links de zoomfactor instellen als je beeld erg on-
stabiel is, maar je kunt ook de voorinstellingen gebruiken.
Selecteer Geen randen. Zet de instelling op Extreem. Zet de Automatische Zoom op 90 en laat
de Max. Autom. Zoom staan. Klik nu op de knop Omzetten en Afspelen. Studio begint met het
renderen. Het duurt wel erg lang voor het is uitgerekend.
Als het renderen klaar is, laat Studio direct ons stabilisatie-effect zien in het voorbeeldscherm.

In Studio zit ook een stabilisator van NewBlue. Deze functie zit onder Add-ons > Stabilisator.

BEELDEN VERBETEREN Studio
Zet een frame op de tijdlijn. Om straks het verschil te zien van de verbetering maken wij even
een kopie van het eerste frame. Selecteer nu het tweede (kopie) frame. Ga naar Effect en klik
op Camera > Belichting. Studio past nu automatisch de belichting aan.
Om het verschil te zien van deze verbetering zet je het gekopieerde frame onder het eerste fra-
me. Door links naast de tijdlijn het oogje van het tweede frame in en uit te schakelen, zie je
het verschil wat automatisch door Studio is aangenomen.
In het uitklapmenu kan je zelf nog gaan corrigeren.
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Andere mogelijkheid om het beeld te verbeteren is:
Ga naar de Media-Editor > Verbeteren. In het uitrolmenu kan je nu zowel de belichting als de
kleur corrigeren.

SPLIT/SJABLOON SCHERM MAKEN Studio
In Studio zit een functie om een videobeeld in verschillende vakken te projecteren. Hierdoor
kunnen we bijvoorbeeld een compilatie van verschillende video’s of foto’s maken aan het be-
gin of halverwege een film. Dit is vooral handig als je naast filmen ook fotografeert.
Klik in de tijdlijn op de knop Gedeeld Scherm Maken. Er start een Editor, waar we eerst het
scherm indelen en ik selecteer in het vak Vormgereedschap de knop Rechte Lijn. Nu kan ik
meerdere vakken maken in het voorbeeldscherm door lijnen te trekken over het scherm, waar-
bij de lijnen automatisch op elkaar aansluiten. Het maakt niet uit hoeveel lijnen we in het veld
zetten. Elk toegevoegd veld krijgt een nummer, dat correspondeert met de vakken onderaan
het scherm. Links kunnen we onze video’s of foto's opzoeken. Daarna naar de invoegvakken
slepen, of direct in het vlak slepen. Als het Selectiepijltje actief is, kunnen we een lijn op-
nieuw selecteren en eventueel nog verplaatsen. Wel verdwijnt dan de clip of foto uit het be-
treffende vak en moet je die weer opnieuw invoegen.
We kunnen ook vaste vormen invoegen door een keuze te maken in het vormgereedschap
scherm. Als we klaar zijn klikken we op de knop OK.

We zijn nu terug op de nieuwe tijdlijn. Als de videoclips niet even lang zijn, dan kan je de
clips allemaal op gelijke lengte maken.
Selecteer alle clips en knip ze allemaal tegelijk en verwijder de overbodige stukken. Als je fo-
to’s gebruikt is dat niet nodig, want de foto’s zullen al allemaal even lang zijn. Klik op OK.
Als de clips niet goed in beeld staan, klik dan rechts in de clip en open in Het Uitrolmenu >
Openen In Sub-editor. Klik je in de clip die je wilt bewerken of verplaatsen. Selecteer tabblad
Editor en het Eigenschappenscherm verschijnt. Hier kunnen we de clip op vele manieren be-
werken, zoals verplaatsen en eventueel vergroten. OK.
Hierna kan je de film verder bewerken.

Een andere mogelijkheid om te werken met een gedeeld scherm is het werken met sjablonen.
Links in het scherm staan diverse tekens. Het teken met de drie vierkantjes is de Sjablonen
Editor. Hier zijn veel mogelijkheden. Klik je op Sjablonen dan verschijnen er weer diverse
voorbeelden met een gedeeld scherm. Het gekozen sjabloon op de tijdlijn Trekken. Dubbel-
klik op het frame in de tijdlijn en er komt een montagesjabloon. Ga terug naar de bibliotheek
en zoek de beelden, die je moet hebben.
Bij alle sjablonen moet je het filmfragment of fotoframe met de muis in het scherm met num-
mer of direct in het genummerde vak onder het scherm trekken. Als alle vakken zijn gevuld
OK en je bent terug op de tijdlijn.
Wil je daarna een bepaald vak gaan veranderen, omdat bijvoorbeeld het beeld niet goed zicht-
baar is, dan kan dit.
Klik rechts op het frame en in het uitvouwmenu Openen Subeditor. Er verschijnen nieuwe
tijdlijnen met de film/fotoframes. Selecteer het frame, dat je wilt bewerken. Ga dan naar De
Editor > Eigenschappen en in dat menu kan je het beeld gaan verschuiven.

*Tip! Als je een ingewikkeld sjabloon wilt maken, dan kan je beter eerst het sjabloon maken
op een lege tijdlijn. Als het sjabloon helemaal naar het zin is, maak er dan een filmpje van. Dit
filmpje weer invoegen in de bibliotheek en daarna weer invoegen in je film. Dit voorkomt dat
dit ingewikkelde gedeelte telkens weer moet uitgerekend worden bij het renderen.
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EFFECTEN KOPIËREN IN EEN ANDERE CLIP Studio
Soms komt het voor, dat je een effect op een clip hebt toegepast, die je op allerlei plekken in
de tijdlijn wilt laten terugkomen. Je kunt natuurlijk netjes alle instellingen opschrijven en het
op de nieuwe clip toepassen, maar het kan eenvoudig. Pas de effecten toe op een clip, klik
rechts en kies vervolgen Effecten > alles kopiëren. Ga naar de andere clip en kies plakken. De
effecten staan nu ook in deze clip. Let wel op: het woordje alle geeft aan, dat bij toepassing
van meerdere effecten op een clip, die ook allemaal geplakt worden in de nieuw clip. Er is
geen mogelijkheid gevonden om een enkel effect te kopiëren.
Wel kun je van een effect, waarbij je instellingen hebt toegepast, opslaan als een eigen effect.
Zorg dan, dat er slechts één effect op de clip staat. Opnieuw rechtsklikken en kiezen voor Ef-
fecten > Opslaan als FX compositie. Naam geven, eventueel een beschrijving en OK kiezen.
Je kunt altijd zien, dat er een effect op een clip is toegepast door de paarse lijn bovenin de clip
op de tijdlijn.

3D TEKST IN STUDIO Studio
In Studio kunnen we nu ook 3D teksten maken en met keyframes bewerken om op allerlei
wijzen te kunnen manipuleren. Klik op de knop T3D boven de tijdlijn. Er start een geheel
nieuwe editor op. Duurt even voor het werkscherm te voorschijn komt.
Type een tekst rechtsboven in het titelvak. Aan de linkerkant zijn verschillende voorinstellin-
gen mogelijk en daar moet je gewoon mee experimenteren. Het is teveel om het op papier uit
te leggen.
Al deze instellingen kunnen we ook aan de rechterkant instellen. In diverse uitvouwmenu’s
zitten weer diverse mogelijkheden. Klik op één van deze en de tekst verandert, zoals de kleur,
structuur enz. Stel de tekst in zoals jij het wilt.
Als we een bepaalde zijde willen bewerken kunnen we rechts in de balk de betreffende kant
selecteren. Dit zijn de 4 vakken boven de tijdlijn, maar dit is meer voor de ver gevorderde.
We stellen nu de tijdsduur in van de animatie. Dat kan ook door de blauwe balk boven de tijd-
lijnen naar rechts te slepen. Achteraf kan je de tijd nog verlengen of verkorten. Wil je met de
tekst veel animaties gaan maken, dan heb je wel een langer frame nodig anders staan de bewe-
gingen te dicht op elkaar. Na op OK geklikt te hebben kunnen we eventueel ook op de tijdlijn
de tijd nog verlengen.
Ga de tekst nu animeren met keyframes en zorg dat de scrubber vooraan staat en de regelposi-
tie geselecteerd is in het tijdlijnscherm. Boven de tijdlijn staan diverse symbolen zoals een
HANDJE, een VIERKANTJE voor DRAAIEN en een vierkantje voor het wijzigen van het for-
maat. Deze gebruik je als je de tekst gewoon stil wil laten staan op een vaste plaats. Wil je de
tekst laten bewegen, gebruik dan de functies, die helemaal links aan de zijkant onder het titel-
scherm staan. Zorg er weer voor dat de scrubber aan het begin van het frame staat. Ga nu met
onderstaande mogelijkheden de tekst maken als beginpositie.

POSITIE is de tekst verplaatsen en kan ook met het handje.
ORIENTATIE is de tekst draaien zowel horizontaal als verticaal.
SCHAAL is de tekst aan alle kanten het formaat aanpassen.
KLEUR spreek voor zichzelf.
DEKKING is de tekst lichter of donkerder maken.

Als je de tekst naar eigen idee heb bewerkt, dan staan er aan het begin van de tekst tijdlijnen
witte ruitjes. Dit zijn de Keypoints. Plaats de scrubber iets verder en bewerk de tekst weer met
de aantal mogelijkheden zoals draaien, verplaatsen of kleur enz. Selecteer weer de regel posi-
tie. Plaats bijvoorbeeld de tekst naar het midden van het voorbeeldscherm en selecteer de
knop draaien en met de muis kan je de tekst alle kanten op bewegen. Draai de tekst zo dat het
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achterstevoren staat, platter wordt of van kleur verandert. Zodra je iets verandert verschijnt er
Een Keypoint per veranderd onderdeel.
Plaats de scrubber weer verder op de tijdlijn en je kunt de tekst weer gaan veranderen. Dat kan
je net zoveel keer doen als je wilt.
Met de X/Y/Z symbolen kan je het formaat van de tekst precies  per tijdlijnregel instellen. Er
zijn in deze 3D editor vele mogelijkheden om een 3D tekst te maken.
Wil je achteraf toch weer naar bewerken, klik dan rechts in de tekstclip en selecteer in het uit-
rolmenu Bewerken Titel en het werkmenu komt weer te voorschijn.

AFBEELDING VAN TIJDLIJN EN BENAMING Premiere e.a.
Vraag: Uitgangspunt tijdlijn van een opgenomen film  met programma Adobe Premiere Pro
CS6. Als men van een scène een foto gemaakt is, krijg je een scherm te zien, waarin op de
bovenste rij b.v. staat: 00969.MTS.Still001. De aanduiding 00969MTS komt van de eerste
scène op de tijdlijn. Volgende foto’s van een scène op de tijdlijn hebben dezelfde eerste 10
tekens gevolgd door “Still etc”. Is er een trucje om de naam van alle foto’s te nemen van de-
zelfde tijdlijn te laten beginnen met een zelf vooraf gekozen naam b.v.  “Wittel.Still001
etc …?
Antwoord: Het is standaard, net als in diverse andere programma’s. Een snelle manier is bij-
voorbeeld de tekst veranderen in Engeland 01. De tekst even kopiëren en bij de volgende af-
beelding het in het tekstvak plakken en dan de 1 in 2 veranderen, enz. De 0 ervoor is cruciaal,
omdat bij meer dan 10 getallen een en ander niet meer op volgorde staat. Toch kan dit niet
altijd even overzichtelijk zijn, omdat je dan precies moet weten, wat het plaatje is. In voorko-
mende gevallen is het dan wijs om bijvoorbeeld een tekst in te voeren als Boot of Gebouw. Je
weet dan meteen wat je opgeslagen hebt.

SGD Uitleg 2019_20 34 of  61



BEELDEN VERSNELLEN Premiere
Vraag: Is er in het Premiere CS6 programma een instelling, waarmede ik het afspelen op de
tijdlijn sneller kan laten verlopen als normaal?
Antwoord: Rechtsklikken op de clip in de tijdlijn. Kies Speed/Duration en wijzig Speed (snel-
heid).

VERKLEIND BEELD MET TEKST IN ZWART GEDEELTE Premiere 
Vraag: Beeld in scherm ‘al lopend’ verkleinen en titel in zwarte deel.
Antwoord: Wat willen we gaan maken? Als eerste uitgaande van Adobe Premiere CS6.
We willen het volgende bereiken:
Stap 1: We willen naast de clip een tekstblok laten zien, echter alles in de 16:9 verhouding. 
Stap 2: ( 2 mogelijkheden)
< Via een New Title wordt de ruimte aan de rechterkant van 45% gevuld met een blok

tekst in één keer verschijnend in beeld.
< De ruimte ter rechterzijde wordt gevuld met een tekstblok, waarbij de tekst al lopend

per letter of per regel het geheel vult.

Begin eerst met de voorbereidingen.

Tekstverwerker
Zorg eerst, dat je alle tekstblokken uitgewerkt hebt in b.v. kladblok of tekstverwerker. Deze
wordt dan gebruikt om te kopiëren en in de titel te plakken, houdt ook rekening met de breed-
te van het tekstveld in de titel.

Premiere
< Zet de clips of stils op de tijdlijn.
< Begin eerst met de titels te maken, kopieer de tekst. welke je gemaakt hebt in de tekst-

verwerker. Waarom de tekst in de tekstverwerker? Je kunt de taalfouten er makkelijker
uit filteren. De titel maak je eerst helemaal compleet tot alles naar je zin is, grootte,
lettertype, positie en je bepaalt of je een stilstaande tekst wil of een rollende.

< Heb je de eerste titel gereed, dan ga je de volgende maken vanuit deze titel. Dit doe je

door de titel te openen en vervolgens op het icoontje  New Title Based on Current
Title te klikken. Je neemt dan alle instellingen over. Wijzig vervolgens de tekst (ook
hier kun je kopiëren en plakken) en herhaal dit voor het aantal titels, dat je wilt hebben.

< Bepaal de plek, waar je de tekst wilt in brengen en plaats daar de scrublijn.

Je gaat nu werken in het Effect Control Venster.
Hier zal je ook de scrublijn zien staan. Zie je de lijn niet, controleer dan of de clip wel gese-
lecteerd is. Zo niet, doe dat dan alsnog in de tijdlijn.
In het Effect Control Venster zoek de volgende instellingen: Position en Scale. Begin met Sca-
le. Klik eerst op het stopwatch icoon, welke voor Scale staat. Hierdoor genereer je een keyfra-
me, verplaats de scrublijn bijvoorbeeld 1 seconde verder, klik op het ruitje aan de rechterzijde
en genereer de volgende keyframe. Vervolgens wijzig je het getal 100 in 55. Klik nu op het
driehoekje links van het keyframeteken. Je ziet dat de scrublijn naar de eerste keyframe
springt.
Selecteer nu de stopwatch van Position. Je krijgt een keyframe op dezelfde plek als bij Scale,
omdat hier de scrubber staat. Ga weer de seconde verder en wijzig het getal 960 in 526. Hier-
door schuift de clip naar links. 
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Je hebt nu vier keyframes gemaakt. Je kunt nu kijken of dit naar je zin is. De keyframes kun je
eventueel selecteren en verplaatsen naar een ander plek, als je niet tevreden bent.

Om de clip weer naar 100% terug te brengen doe je hetzelfde. Plaats bepalen, eerst keyframe
plaatsen, waar hij mee moet beginnen door alleen op het ruitje te klikken en vervolgens de
keyframe te plaatsen, zoals die uiteindelijk moet zijn. Alles kun je ook nu8 naar je eigen in-
zicht aanpassen en verplaatsen.

Animeren van de titel
Je kunt in het Titelvenster simpelweg voor een roltitel kiezen, maar je kunt de titel natuurlijk
ook zelf animeren. Ook hier gaan we keyframes inbrengen op dezelfde manier. Je wilt vervol-
gens de tekst uit de titel laten rollen van onder naar boven en dit moet strak aansluiten op het
moment, dat de clip op zijn plek staat.
De titel kun je als volgt exact uitlijnen: plaats als referentie de scrublijn op de plek, waar het
allemaal moet gebeuren, selecteer in de tijdlijn de titel, houdt de Alt toets ingedrukt en gebruik
de pijltjes toetsen links of recht om het juiste moment voor te krijgen.
Wil je de titel met de stilstaande tekst laten in- en uitfaden gebruik dan de optie Scale of Opa-
city en werk ook hier met de keyframes. Denk eraan: altijd eerst op de stopwatch klikken voor
het genereren van de eerste keyframe. Is deze al actief en wil je de betreffende keyframes ver-
wijderen, dan kun je hem simpelweg uitschakelen door er op te klikken. Alle keyframes zijn
dan verwijderd.
Het mooiste werkt alles, als je de titel zelf (animeren) in beweging brengt. Dat kan door te
werken met de keyframes. We willen de b.v. de titel van onder af op laten komen en laten
stoppen tegen de bovenste rand.
We maken eerst de titel en kijken hoelang in tijd hij moet zijn, let vooral op de grootte van het
lettertype. Zodra de titel klaar is en op de tijdlijn staat, kan je deze net zo bewerken als een
videoclip. Dus selecteer de titel op de tijdlijn, zodat je hem in het Effect Controls venster ziet.
Deze kan je dan ook bewerken met de functies Position en Scale. Om de titel van onder om-
hoog te laten lopen plaats je de titel buiten beeld, het getal 540 moet dan b.v. 1400 zijn. Con-
troleer of de keyframe er staat. Verplaats de scrublijn 1 seconde en wijzig 1400 in 540. Wil je
nog een tekstregel invoeren, maak dan een nieuwe titel met dezelfde functie New Title Based
on Current Title, zoals hiervoor beschreven en zorg dat deze dan onder de andere tekstregel
op juiste afstand komt te staan. Zo kan je doorgaan als je meerdere regels wilt invoeren. Elke
regel in een nieuwe titel, welke in de tijdlijn netjes boven elkaar komt te staan, enkel in tijd
verschoven om in beeld te komen.

Ook hier telt Oefening baart kunst, wees niet bang om fouten te maken de functie Ctrl Z (een
stap terug) is geduldig en maak notities.

Ik wil nog een tip meegeven, de instellingen van de keyframes kan je wijzigen, maar let op,
dat je op de keyframe staat als je iets wijzigt. Sta je ernaast en je wijzigt iets, dan krijg je een
nieuwe keyframe en zal er een gekke beweging komen in het verloop.

WERKEN MET GREEN OF BLUE SCREEN Premiere
Een opmerking vooruit het werken met een green of blue screen ofwel Chromakey is niet di-
rect eenvoudig, zelf de grote jongens in Hollywood hebben hier problemen mee het is niet een
1,2,3-tje als vanzelf. Elk montagepakket heeft wel een effect om met deze functie te werken,
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dus hier is niks uitzonderlijks. Echter het ene pakket gaat iets dieper in de bewerking dan het
andere. Ook wordt vaak een andere benaming gebruikt, want immers de eigenlijke benaming
is Chromakey. 
In mijn voorbeeld gebruikte ik een bestaande clip met een waterpartij, hierboven een green-
screenclip met rendieren en ik had de beschikking over slingers met kerstballen, de slingers
zijn groene dennentakken. Hier kun je dus geen greenscreen toepassen en moet je een blauwe
achtergrond gebruiken. In de voorbeeldclip was deze mogelijkheid aanwezig.
De clips met de greenscreen had ik gedownload van YouTube, waar legio van deze clips aan-
wezig zijn.
We blijven bij Adobe Premiere Pro. Hier gebruiken we de functie of effect Ultra Key, waar-
om? Omdat we hier welke kleur ook kunnen selecteren om een Alfakanaal te maken. Een al-
fakanaal in computergraphics is een onderdeel van een afbeelding of videobeeld die gedeelte-
lijk doorschijnend weergegeven kan worden. De
Engelse noemen dit Alpha Blending of Alpha
Channel. Hierbij wordt de afbeelding of clip ge-
combineerd met de achtergrond. Het meest wor-
den groen of blauwe achtergronden gebruikt bij
de opnamen. Net zoals alles met opnemen van de
scènes dient een en ander goed uitgelicht te wor-
den. Dit is wel heel belangrijk.
Het Ultra Key effect sleep je naar de clip met de
groene of blauw gekleurde achtergrond. Selecteer
de clip en ga naar het Effect Control Venster. Bij
het Ultra Key Effect zie je een pipet, klik hierop
en tik in de Program Venster op het gekleurde vlak zo kort als mogelijk bij het object, dat je
wilt blijven zien. Het gekleurde vlak, groen of blauw zal gelijk verdwijnen. Binnen dit effect
zijn er een aantal instel mogelijkheden zoals, Output hier kun je kiezen voor Composite, dit
staat standaard aan, Alpha Channel, met deze instelling zie je de oneffenheden in het beeld,
welke je kunt corrigeren met Matte Cleanup, Spill Suppression en Color Correction e.a. zal je
zelf moeten uitvlooien er zijn geen standaard instellingen.

Keyframes
Zoals je ziet kan je in het Effect Control venster
je beelden bewerken en animeren. Dit doe je door
het plaatsen van Keyframes achter de diverse op-
ties zoals Position, Scale, Rotation, Anchor Piont
etc. overal waar een stopwatch icoontje voorstaat
kun je de diverse waarden van plaats en grote
aanpassen in de tijd. Ook zijn er diverse soorten
Keyframes zoals Linear, Bezier, Auto Bezier,
Continuous Bezier en Hold. Linear is de stan-
daard en zal een hoekige animatie geven. Wil je dit wat vloeiender hebben, dan zal je een van
de Bezierfuncties moeten gebruiken. Welke voor jouw doel het gewenste effect heeft, zal je
zelf moeten bepalen. In het voorbeeld zie je dat de buitenste keyframes een wat andere icoon
hebben de eerste (linkse) staat voor Ease In, dit zal een rustig inkomend effect geven en de
laatste (rechts) is Ease Out wat weer een uitgaand effect geeft.

EXPORTEREN Premiere
Vraag: Wil je het exporteren nog eens onder de loep nemen?
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Antwoord: Een uitgebreid antwoord op deze vraag vind je in de uitleg van 2017 onder het
hoofdstuk exporteren. Ook de uitleg over de bitrate vind je daar. Hierin worden alle opties en
vensters van de exportfunctie uit CS6 genoemd. De exporteermogelijkheden van CC zijn
praktisch gelijk. Altijd handig om eens na te slaan.
De adviezen van vanavond staan hieronder.

Zorg ervoor, dat de sequence, die geëxporteerd moet worden actief is en dat het werkgebied
de hele montage in de tijdlijn beslaat. Wil je een gedeelte van de montage exporteren zorg er
dan voor, dat het werkgebied aangepast wordt aan het gekozen exportdeel. 
Zorg er ook voor, dat alles gerenderd (uitgerekend) is. Eventueel alsnog doen via Entertoets.
Alle rode lijntjes van niet uitgerekende stukken zijn nu geel.
Een enkele keer kan het voorkomen, dat een film naar je gevoel toch niet helemaal goed loopt,
dan kun je ook nog kiezen voor Sequence > Render Entire Workarea. Alle gele lijnen (uitge-
rekende delen) worden nu groen.
Sla het project op.

Ga naar File > Export en
je ziet een rijtje met ex-
portopties. We kiezen
voor Media (CTRL M) .
Het venster Export Set-
tings wordt geopend. Klik
je op Format dan zie je
een eindeloze hoeveelheid
exportopties.

Even een tip:
In het verleden hebben we
vaak geadviseerd om te
kiezen voor Match Se-
quence Settings. Gemak-
kelijk en altijd goed. Ge-
bleken is echter dat dan met een hoge bitrate geëxporteerd wordt en die bitrate kan niet aan-
gepast worden. Als gevolg hiervan kunnen problemen met het afspelen voorkomen, als de
gebruikte apparatuur dit niet goed aan kan.

We gaan exporteren in HD 1080p of 1080i en kiezen Format > H264. Wil je exporteren naar
50p, dan kan het zijn, dat die optie er niet in staat. Kies dan Presets > HD 1080p 25.  Je kunt
na de keuze van HD 1080p 25 onder de tab Video > Frame Rate wijzigen in 50. Wil je die
instelling bewaren voor later, sla het dan op via het pijltje achter Preset (= Save preset). Geef
het een naam en voortaan staat het bovenin je lijst. dit kan natuurlijk altijd voor een export-
functie, die je steeds wilt gebruiken.
Onder de tab Audio kun je eventueel de Audio-instellingen wijzigen en de bitrate hiervoor
aangeven.
Onder Summary kun je alle instellingen vinden, die je aangegeven hebt.
Let wel altijd op Output Name. Vul hier achter de naam van je bestand in en zorg, dat die in
de juiste map geplaatst wordt.

Bitrate Settings
Ook belangrijk: de bitrate settings. Je vindt ze onder de tab video. We zien CBR en VBR.
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Bitrate is de snelheid, waarmee de informatie-overdracht plaats vindt. Mbps staat voor Mega-
bits per seconde. Hoe hoger de bitrate, hoe sneller de data-overdracht. Een lijstje:
7000 Mbps = 1u15
6000 Mbps = 1u25
5000 Mbps = 1u40
4000 Mbps = 2u00
Zoek een bitrate, die zeker niet hoger is dan 7000. Daarboven kunnen afspeelproblemen ont-
staan, zoals we al vaker op de club geconstateerd hebben.
Maar ook: een lagere bitrate dan het origineel geeft kwaliteitsverlies.

Bitrate encoding
Hier kun je kiezen tussen CBR (Constant Bitrate) en VBR (Variable Bitrate). Bij VBR is er
ook nog de keuze tussen 1 Pass en 2 Pass.
CBR: geeft elk moment dezelfde kwaliteit, ongeacht of er veel of weinig actie in beeld is.
Veelal de voorkeurskeuze.
VBR: de datarate wordt automatisch aangepast aan de actie in je film. Wanneer iets in beeld
komt met weinig beweging (close-up van een persoon, landschap, ...) dan daalt de datarate
naar een minimum, omdat er
niets essentieels verandert in
je beeld. Heb je echter plots
actieve beelden (auto rijdt
voorbij, of mensen wandelen
op een marktplein) dan stijgt
de datarate om de kwaliteit
te blijven behouden. Nu niet
meer zo relevant, maar om
het even aan te geven:
doordat de datarate uiteinde-
lijk daalt, krijg je bijvoor-
beeld op een DVD meer mi-
nuten film.
Je kunt hierbij ook nog kie-
zen tussen 1 Pass en 2 Pass.
Bij 1 Pass wordt de montage
in een keer omgezet naar
MPEG2. Bij 2 Pass wordt de
film eerst geanalyseerd en
daarna omgezet. Dit duurt 2x zo lang, maar resulteert in een betere MPEG-kwaliteit.

INSTELLINGEN  PREMIERE PRO Premiere Pro
Er zijn binnen het Prefences menu een aantal instellingen welke belangrijk zijn voor het opti-
maal functioneren van je montagesysteem ofwel je computer. 
< Audio. Hier kun je het vinkje weghalen bij ‘Play audio while scrubbing’. Standaard

staat dit vinkje aan, waardoor je het audio spoor hoort, als je met de scrubline over de
tijdlijn beweegt. Er zijn mensen welke dit storend vinden. Let ook op dat bij ‘Render
Edit Audition files to:’ de button bij de optie Scratch disk staat.

< Audio Hardware. Dit spreekt voor zich en is afhankelijk van de audiohardware, die in
je pc aanwezig is.

< Auto Save. Hier kun je de tijd instellen, het aantal minuten, dat er automatisch een
reservebestand wordt gemaakt. Standaard staat die op 15 minuten. De andere vinkjes
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blijven uit anders gebeurt e.a. dubbel op. Auto Save en Project Save zijn niet hetzelfde.
De eerste kan de reddende engel zijn, als er iets gebeurt met je systeem. Er kunnen
maximaal 20 varianten van Auto Save worden opgeslagen, als je dat ingesteld hebt.
Mocht het gebeuren, dat je via Auto Save je project wilt opstarten, kijk dan goed naar
de tijdeenheid van de opslag.

< Media Cache. Binnen deze instelling wijzig je alle locaties, die verwijzen naar een
map op de C-schijf of je systeemschijf, want anders zal deze ongemerkt zachtjes vollo-
pen.

< Memory. Adobe kiest hier binnen je systeem voor de ideale verdeling van het geheu-
gen, zodat het systeem optimaal werkt. Daarom is ook bij de instelling Performance bij
‘Optimize rendering for:’ Memory gekozen.

< Playback. Maak je gebruik van een tv als previewscherm, dan zal je die hier zien. De-
ze kun je dan aanvinken. Heb je de mogelijkheid van meerdere monitors gebruik dan
het Programma Venster binnen Premiere Pro.

Sequence Settings

< Editing Mode. 
Hier kies je voor een instel-
ling, die gelijk is aan je
camera-instelling. Heb je
deze niet paraat, geen nood.
Kies voor een Sequence zon-
der instellingen. Dit kun je
zien, want er staat dan achter
‘Timeline: (no sequences)’.
Deze genereer je door se-
quences, welke geopend zijn,
in het timelinevenster te slui-
ten en dan een clip de timeli-
ne binnen te trekken. Er
wordt dan vanzelf een se-
quence gegenereerd op basis
van die clip. Als je daarna de
sequence instellingen opent,
dan kun je de juiste instel-
lingen zien. Nog mooier is,
dat je deze je eigen kunt ma-
ken door nogmaals te kiezen
voor een nieuwe sequence
(Ctrl+N). Selecteer vervolgens de tab ‘Sequence Presets’ en kies voor dezelfde instellingen.
Als voorbeeld heb ik gekozen voor AVCHD 1080i25 (50i). In de witte vlakken zie je de hele
instelling beschreven. Nu kun je onder de volgende tab ‘Settings’ je eigen instellingen zien en
controleren en eventueel wijzigingen aanbrengen.
Alles oké? Dan gaan we naar de volgende tab ‘Tracks’ hier kun je instellen met hoeveel vide-
osporen je het project wilt starten. Uitbreiden van de video- en audiosporen is altijd mogelijk
en binnen het blok Audio kun je de instelling hiervan bepalen. Je kunt hier ook audiosporen
toevoegen door op het plusteken te klikken of verwijderen door de geselecteerde te verwijde-
ren door op het minteken te klikken, tevens kunnen we de namen veranderen onder de kolom
‘Track Name’, b.v. live01, live02 en muz01 enz… Bij de kolom ‘Track Type’ zien we altijd
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standaard, dat er een aantal 5.1 sporen zijn. Werk je voornamelijk in stereo zet dan alle tracks
op Standaard. Hebben we alles naar wens ingesteld, dan kiezen we onderaan voor ‘Save Pre-
set…’
Het pop-up venster verschijnt, waarin je een voor jou herkenbare naam kunt invoeren. Dit ge-
daan hebbende zal je bij de opstart van een nieuw project altijd deze instelling kunnen selecte-
ren. Het is iets minder dan een half uur werk, maar je hebt er bij de volgende projecten voor-
deel van. 
De AVCHD-instelling voldoet op dit moment voor de meeste consumentencamera’s. Kies je
echter voor een sequence met andere instellingen, let dan vooral goed op, dat bij ‘Video Pre-
views’ de ‘Preview File Format’ staat ingesteld op ‘I-Frame Only MPEG’. Dit heeft te maken
met de weergave naar je monitor of je moet over een monitor beschikken voor hoge grafische
weergave.

ZELF EEN INSTELLING VOOR DE TIJDLIJN MAKEN Premiere
Als je veel in eenzelfde bestandsformaat werkt, dan is het handig om dat lekker bij de hand te
hebben in je montageprogramma. Hoe doe je dat bij Premiere?
Kies bij het opstarten de sequence, die je het dichtst bij jouw instellingen komt. Of kies, als je
al in de montage zit voor New Sequence. Als voorbeeld en bij ons waarschijnlijk het meest
gebruikt: AVCHD 1080p50. Kies vervolgens het tabblad Settings. Alle instellingen hebben
een uitklapmenu. Kijk er naar en wijzig waar nodig. In dit geval staat het allemaal naar wens.
Ga dan naar het tabblad Tracks. Ook hier de standaardinstellingen. We zien 3 videotracks.
Kun je gewoon laten staan. Immers je kunt heel gemakkelijk meerdere tracks bijmaken.
Bij audio is het anders. Daar zie je 6 tracks staan, waaronder 3x een 5.1 track. De meesten van
ons zullen geen 5.1. geluid gebruiken, dus kun je die veranderen in Standard en kijk dan met-
een even of je wel 6 tracks nodig denkt te hebben. Bekijk ook de andere opties bij het uitklap-
menu. Tevreden? Kies Save Preset en klik OK.
Je eigen instelling staat nu onderin je Available presets in de map Custom.
Nooit meer zoeken naar de juiste instelling voor de tijdlijn.

DIAGONALE STREPEN OP CLIPS IN TIJDLIJN Premiere
Vraag: Op de tijdlijn zijn zowel op de balk video als audio schuine strepen verschenen. Wat is
dat? Waar komen deze vandaan? Hoe kan ik ze weer weg krijgen?

Antwoord: Verwar deze strepen niet met de diagonale strepen, die je krijgt als je een tijdlijn
op slot zet. Die zien anders uit. Wat zijn het dan wel? De strepen worden door sommigen
“Danger Stripes” genoemd en geven aan, dat de clips niet meer gelinkt zijn aan het materiaal,
dat in het projectvenster staat. Het kan ontstaan, doordat je bijvoorbeeld vanaf een losse schijf
werkt en de ene keer de schijf gebruikt heb op je laptop in de huiskamer en daarna weer lekker
wil verder gaan op je pc in je hobbykamer.
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Voor de duidelijkheid: er is niets mis met het materiaal op je schijf, dat is nog gewoon bereik-
baar. Het is een probleem intern in het programma.

Het is vrij simpel op te lossen. Klik vanaf de bewuste clip op de rechtermuisknop en kies in
het keuzemenu Reveal in project. In het projectvenster, wordt nu de gebruikte clip geselec-
teerd. Ga terug naar je clip, klik weer rechts en kies Replace with clip > from Bin. De strepen
verdwijnen en de clip is weer zichtbaar.
Je zult het wel bij alle clips moeten herhalen.

Het probleem kan zowel voorkomen bij video, audio of gecombineerd, alsook grafisch materi-
al. Dus in principe alle soorten materiaal, die je in de tijdlijn gebruikt heb.

FOTO UIT TIJDLIJN GEMAAKT, VERVORMT NA BEWERKING
Vraag: Film op de tijdlijn (CS6) breed 16:9 uitgangspunt. Te zien op de op tijdlijn een schil-
derij >> hoogte iets meer dan de breedte. Ik maak een foto in b.v bmp.
Resultaat: Overduidelijk meer hoogte dan breedte, een verhouding die duidelijk niet over-
eenkomt met de werkelijkheid (zoals te zien op de tijdlijn en ook op de foto van de museum-
gids). Waar is  er iets fout gegaan? En hoe op te lossen?

Een paar screenshots:

                

Antwoord: Ik kan niet precies nagaan, wat je gedaan hebt. Duidelijk is in ieder geval, dat bij
het wijzigen de breedte en hoogte van de afbeelding niet gekoppeld waren. Hoe je dat doet
kom je in de uitleg hieronder tegen. Het is de uitleg over de gemakkelijkste wijze om iets der-
gelijks te realiseren. Overigens: in veel gevallen is voor een foto van een bekend schilderij een
zoektocht op internet of een scan uit een folder wel zo gemakkelijk.

De uitleg
• Beeld met schilderij met achtergrond staat in de tijdlijn. Perspectief is wat schuin.
• Foto maken via Export Frame (CTRL + Shift + E, ook: foto-
toestel onder Programmonitor)
• In venster dat te voorschijn komt kun je een naam geven en de
plek op de pc-schijf. Kies bij format bij voorkeur voor PNG, TARGA
of JPEG. Vanwege de mindere kwaliteit geen GIF, DPX of BMP.
OK.
• Openen in Photoshop.

Omdat de afbeelding in perspectief staat met de daarmee samenhang-
ende schuine vertekeningen heb je een probleem. Ik neem aan, dat je
een afbeelding uitsluitend van het schilderij wilt hebben. Bekend is
het gereedschap Crop Tool om een deel van een afbeelding uit te

SGD Uitleg 2019_20 42 of  61



knippen. Daarnaast heeft Photoshop het prachtige gereedschap Perspective Crop Tool (per-
spectief knippen). Zie hiernaast. Zie je een ander icoontje op die plek staan, klik dan even op
het driehoekje rechts onderin het icoontje en je krijgt een uitvouwvenster met mogelijkheden.
Met een muisklik komt het juiste gereedschap te voorschijn. In de uitleg van 2017 wordt dit
gereedschap uitgebreid behandeld.

Nu even kort.

Zorg er altijd voor, dat breedte en hoogte van
de afbeelding aan elkaar gekoppeld zijn (Ima-
ge, Image Size, Constrain Proportions of Af-
beelding, Afbeeldingsgrootte, Verhoudingen
behouden). Sleep nu een kader om de lijst
heen. Verfijn het door met de puntjes te slepen.
Tevreden?

Klik OK en je hebt een prima afbeelding zonder perspectiefver-
tekening.

PREMIERE ELEMENTS
Er is, zij het een beetje moeizaam, uitleg gegeven over de grafische mogelijkheden van Pre-
miere Elements. Voor de Elementsgebruikers zijn er een serie voorbeeldfilms beschikbaar.
Vragen aan Joke, dan worden ze op een usb-stick gezet.

EFFECTEN OOK OP ANDERE CLIPS TOEPASSEN Premiere (Elements)
Bij een uitleg kwam ter sprake, dat bepaalde effecten opnieuw op andere clips in de tijdlijn
toegepast dienden te worden. Dat kan natuurlijk op allerlei manieren, maar in Premiere Ele-
ments kan dit heel eenvoudig. De werkwijze is praktisch gelijk aan die in Premiere.

Alle effecten kopiëren en plakken
1. Selecteer de clip met de effecten, die u wilt kopiëren in de tijdlijn van de Professionele

weergave.
2. Kies Bewerken > Kopiëren. Hiermee worden alle clipkenmerken gekopieerd.
3. Selecteer in de tijdlijn van de Professionele weergave de clips, waarop u de gekopieer-

de effecten wilt toepassen.
4. Kies Bewerken > Effecten en aanpassingen plakken. Hiermee worden alle kenmerken

van de eerste clip naar de tweede gekopieerd.
Je kunt de opdrachten Bewerken > Kopiëren en Bewerken > Kenmerken plakken ook
gebruiken door met de rechtermuisknop te klikken of door Ctrl ingedrukt te houden en te
klikken
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KNIPPEN IN GELUID Premiere Elements
Vraag:  Ik wil in Premiere Elements geluid (niet gekoppeld aan beeld) knippen en delen ver-
schuiven. Hoe doe ik dat.
Antwoord: Ga in de tijdlijn op de te knippen plek in de tijdlijn staan. Erboven zie je in de
scrublijn een schaartje verschijnen. Hiermee geef je de knip aan en klaar is Kees.

GEEN GELUID Premiere Elements
Vraag: Als ik mijn clips in het programma heb staan, dan hoor ik geen geluid. Als ik vervol-
gens exporteer, dan geeft de gemaakte video wel geluid. Ik heb dat al eerder gehad en alle op-
ties van toen weer eens doorgenomen, maar ik kan het niet vinden.
Antwoord: Kijk of op de juiste plaatsen vinkjes staan in de Voorkeuren en kijk ook of voor de
juiste Audiohardware gekozen is. Een van de aanwezigen gaat bij de vrager kijken.

Het geluidsprobleem in Elements is het opgelost. E.e.a. blijkt aan de instellingen te liggen bin-
nen Elements.
Ga in Elements naar Bewerken, dan Voorkeuren. Je krijgt een scherm waarin je kan kiezen
voor Audio Hardware. Klik hierop en je zal vermoedelijk een instelling zien, waar de tekst in
voorkomt: Not working. Klik hierop en selecteer waar dit niet achterstaat. Naar mijn beleving
heeft e.e.a. te maken met Updates van zowel Windows als Elements.

PROBLEMEN MET OPNEMEN - PREMIERE  ELEMENTS
Vraag: Ik heb problemen met het opnemen van film in Premiere Elelemts. Er komt te staan: 
“U kunt niet opnemen zonder minstens één track in te schakelen voor opnemen”. 
Antwoord: Een track is een tijdlijn. Zorg ervoor, dat er een tijdlijn ingeschakeld staat. Zie D
op het plaatje hieronder.

TITEL OPSLAAN div. programma’s
Vraag: Even een vraag over de titels in Premiere CS6. Wanneer ik een titel heb gemaakt in
een film met alle aanpassingen, dan zou ik die willen bewaren als een soort eigen Template.
Het is al een keer langs gekomen, maar ik kan niet meer vinden hoe dat moet. Inmiddels
schrijf ik alle instellingen maar op een blaadje. Het lijkt me niet dat dat de bedoeling is. Mis-
schien is dit een keer besproken met een ander montage programma. Ik hoop dat dat ook met
CS6 kan.
Antwoord: Premiere: Maak je titel in het titelvenster. Klik op Templates (CTRL J) en vervol-
gens op het pijltje rechts boven in het venster. In het uitklapmenu kies je Import Current Title
as Template. Geef de titel een naam. Je titel komt nu onder Users Templates te staan.
Studio 14: Maak je titel. Geef de titel linksbovenin het venster een naam. Ga naar Bestand >
Titel opslaan als. Je kan zien, dat de titel automatisch opgeslagen wordt in
C:\Users\Public\Documents\Pinnacle\Content, of in de map, die je hebt aangegeven bij de
instellingen. Je kunt ook zelf ergens een map aanmaken om je titels in te bewaren, of gewoon
een andere map kiezen ervoor. Wil je het in je Titelbibliotheek zien, dan open je links de T (=
titelvak), kies bovenin Mijn Titels en zoek je via de map ernaast het bestand op. Je titel staat
nu in het titelvak. Een vervelend iets is (mijn ervaring), dat je bij ieder nieuw project het be-
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stand weer op moet zoeken. Het bestand blijft niet zichtbaar in de bibliotheek. De titel heeft
de extensie .dtl
Studio 17: (werkt net als in Studio 14) Maak je titel. Kies terwijl je nog in het Titelvenster
bent voor Bestand > Titel opslaan als. Het venster opent standaard in de map, die aangegeven
is bij Instellingen > Opslaglocaties > Titels. Dat kan echter anders zijn, dus let even op, waar
de titel opgeslagen wordt, of zoek zelf de bestemming. Geef de titel een naam en sla op. Titels
opgeslagen in de standaardmap van de van de Titelinstellingen zijn vanaf nu zichtbaar in de
bibliotheek. De titel heeft de extensie .axp. Titels, die ergens anders opgeslagen zijn, kun je
binnenhalen via Snelle Import.

NIEUWE TITEL GEBASEERD OP HUIDIGE TITEL Premiere
Je hebt een titel in de tijdlijn staan en je wilt op een andere plek dezelfde titelopmaak gebrui-
ken voor een nieuwe titel. Dat kun je doen door het titelvenster te openen met de eerder ge-
maakte titel en kiezen voor New Title based on current title.
Eenvoudiger: De titel kopiëren met ingedrukte ALT-toets en vervolgens bewerken, zoals hier-
boven omschreven.

TEKST IN ZWART NAAST BEELD Premiere CS6/CC
Vraag: Ik heb een beeld dat kleiner is dan de rest van mijn film. Nu wil ik dat beeld verschui-
ven en ernaast op een zwarte achtergrond tekst plaatsen. Hoe doe ik dat in Premiere CS6?
Antwoord: Selecteer het beeld in de tijdlijn. Ga naar het Effect Controlvenster. Met de functie
Motion kun je het beeld verschuiven. Er verschijnt nu vanzelf een zwarte achtergrond voor de
tekst. De tekst maak je in het titelvenster. Let dan wel op, dat je in het zwart blijft.
Nu wil je een deel van het beeld ook verbergen achter zwart om daar de tekst over te zetten.
Een van de mogelijkheden is dan de tekst te maken in het titelvenster en in hetzelfde titelven-
ster het vierkant kiezen en een vierkant trekken over het deel, dat je zwart wil hebben. Bij de
instellingen rechts kun je bij Fill kiezen voor Solid en vervolgens als kleur zwart. Als de tekst
achter het zwarte deel verdwijnt, dan kun je via rechtsklikken in het vak kiezen voor Arrange
> bring backwards. Het zwarte beeld staat nu achter de tekst.

Nog een uitleg hierover:
Wat willen we gaan maken. Als eerste uitgaande van Adobe Premiere CS 6.
We willen het volgende bereiken:
Stap 1: We willen naast de clip een tekstblok laten zien echter alles in de 16:9 verhouding. 
Stap 2: (2 mogelijkheden) Via New Title wordt de ruimte aan de rechterkant van 45% met een
blok tekst in één keer verschijnend in beeld. Of: De ruimte ter rechterzijde wordt gevuld met
een tekstblok, waar de tekst al lopend per letter of per regel het geheel vult.
Begin eerst met de voorbereidingen.

Tekstverwerker
Zorg eerst, dat je alle tekstblokken uitgewerkt hebt in b.v. kladblok of je tekstverwerker. Deze
wordt dan gebruikt om te kopiëren en in de titel te plakken. Houdt ook rekening met de breed-
te van het tekstveld in de titel. 

In Premiere
5. Zet de clips of stills op de tijdlijn.
6. Begin eerst met de titels te maken, kopieer de tekst welke je gemaakt hebt in de tekst-

verwerker. Waarom de tekst in de tekstverwerker maken? Je kunt de taalfouten er
makkelijker uit filteren. De eerste titel maak je helemaal compleet tot alles naar
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je zin is, grootte, lettertype, positie. Bepaal of je een stilstaande tekst
wil of een rollende.
7. Heb je de eerste titel gereed, dan ga je de volgende maken.
Dit doe je door de titel te openen en vervolgens op het icoontje New
Title Based on Current Title te klikken. Je maakt dan een nieuwe
titel met gebruik van de bestaande instellingen, maar kan naar belie-
ve een en ander wijzigen. Wijzig de tekst ook hier kopiëren en plak-
ken en herhaal dit voor het aantal titels dat je wilt hebben.
8. Bepaal de plek waar je de tekst wilt in brengen, zet daar de
scrublijn.

Je gaat nu werken in het Effect Control venster.
Hier zal je ook de scrublijn zien staan. Zie je de lijn niet, controleer
dan of de clip geselecteerd is. Zo niet, ga dan naar de tijdlijn en se-
lecteer alsnog.
In het Effect Control venster zoek je de volgende instellingen Positi-
on en Scale. Begin met Scale. Klik eerst op het stopwatch icoon,
welke voor scale staat. Hierdoor genereer je een keyframe. Verplaats de scrublijn bijvoorbeeld
1 seconde verder en wijzig je het getal 100 in 55. Er wordt automatisch een nieuw keyframe
aangemaakt op die plaats. Klik nu op het driehoekje links van de keyframes bij Scale. De
scrublijn zal naar de eerste keyframe springen. Klik nu op de stopwatch van Position. Er ver-
schijnt nu op dezelfde plek als bij Scale een keyframe. Klik op het driehoekje rechts van de
keyframes bij Scale en de cursor staat op de volgende keyframe. Wijzig bij Position het getal
960 in 526. Ook hier wordt weer automatsch een keyframe aangemaakt. De clip zal naar links
schuiven. Je hebt nu in totaal vier keyframes gemaakt je kunt nu kijken of dit naar je zin is.
Eventueel kun je de keyframes selecteren en verplaatsen naar de plek, waar jij ze wilt hebben.

Om de clip weer naar 100% te brengen doe je hetzelfde, plaats bepalen, keyframe plaatsen
waar hij mee moet beginnen door alleen op de pastille te klikken en vervolgens de keyframe
plaatsen van welke het uiteindelijk moet zijn. Alles kun je naar je eigen inzichten aanpassen
en verplaatsen.
De titel kunnen we natuurlijk ook animeren, ook hier gaan we keyframes inbrengen op dezelf-
de manier. 
Je wilt vervolgens de tekst uit de titel laten rollen van onder naar boven en dit moet strak aan-
sluiten op het moment, dat de clip op zijn plek staat. De titel kun je als volgt exact uitlijnen:
plaats als referentie de scrublijn op de plek, waar het allemaal moet gebeuren. Selecteer in de
tijdlijn de titel. Houdt de Alt toets ingedrukt en gebruik de pijltjes toetsen links of recht om
het juiste moment voor te krijgen.
Wil je de titel met de stilstaande tekst laten in- en uitfaden gebruik dan de optie Scale of Opa-
city en werk ook hier met de keyframes. Denk eraan altijd eerst op de stopwatch te klikken
voor het genereren van de eerste keyframe. Als deze al actief is schakel je hem weer uit en dan
zijn de betreffende keyframes verwijderd.
Het mooiste werkt alles, als je de titel zelf (animeren) in beweging brengt. Dat kan door te
werken met de keyframes. We willen b.v. de titel van onderaf op laten komen en laten stoppen
tegen de bovenste rand.
We maken eerst de titel en kijken hoelang in tijd hij moet zijn. Let daarbij vooral op het for-
maat van het lettertype. Zodra het klaar is en op de tijdlijn staat, kan je deze net zo bewerken
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als een videoclip, dus selecteer de titel, zodat je hem in het Effect Controls venster ziet. Je 
kan dan ook werken met de functies Position en Scale. Om de titel van onder omhoog te laten
lopen, plaats je de titel buiten beeld, het getal 540 moet dan zijn bv. 1400, controleer of de
keyframe er staat. Verplaats de scrublijn 1 seconde en wijzig 1400 in 540. Wil je nog een
tekstregel in voeren, maak dan een nieuwe titel met dezelfde functie New Title Based on Cur-
rent Title zoals hiervoor beschreven en zorg dat deze dan onder de andere tekstregel op juiste
afstand komt te staan. Zo kan je doorgaan als je meerdere regels wilt invoeren, elke regel in
een nieuwe titel welke in de tijdlijn netjes boven elkaar staan enkel in tijd verschoven om in
beeld te komen.
Ook hier telt Oefening baart kunst, wees niet bang om vouten te maken de functie Ctrl Z (een
stap terug) is geduldig, en maak notities.
Ik wil nog een tip meegeven, de instellingen van de keyframes kan je wijzigen maar let op dat
je op de keyframe staat, als je iets wijzigt. Sta je ernaast en wijzigt iets, dan krijg je een nieuw
keyframe en zal er een gekke beweging komen in het verloop.

En natuurlijk kun je voor een eenvoudige animatie als scrollen ook simpelweg voor de functie
scroll kiezen in het titelvester.

MOGRO’s of wel Motion Graphics Adobe CC

Motion Graphics zijn grafische elementen, zoals titels maar dit kun-
nen ook grafische onderwerpen zijn. Meestal bouw je die in Adobe
After Effects. Vanaf Adobe CC 2018 en 2019 zijn in Premiere Pro
en After Effects de Essentiel Graphics functies toegevoegd. De ou-
de titel generator is wel nog steeds aanwezig en vindbaar onder File
> New > Legacy Title. Het grafisch bouwen is hierin echter beperkt.

Rechts zie je de functie Essential Graphics, die wordt opgestart als het werkveld Graphics ge-
kozen wordt.

Een eenvoudige titel creëer je door de Type Tool (T)
te selecteren bij de gereedschappen of met de snel-
toets T. Hierdoor wordt er een tekstvenster zichtbaar

(kader met rode rand) waar de tekst ingevoerd kan worden. Zodra de tekst is ingevoerd ver-
schijnt er in het Essential Graphics venster onder Edit de ingevoerde tekst en kunnen alle be-
werkingen vanuit dit venster voor die tekst gedaan worden. Let er wel op, dat de tekstregel
geselecteerd is. Dit laatste is makkelijk te zien, omdat er dan minder instellingen beschikbaar
zijn. Hier komen we later op terug.
We blijven in het venster Essential Graphics. Onder het blok met het tekstveld (lagen) zijn
twee iconen zichtbaar. Met de meest rechtse, het vierkantje met het ezelsoor, kunnen diverse
elementen worden toegevoegd, zoals meerdere tekstregels, diverse vormen en foto’s of films.
We blijven bij tekst invoeren. Willen we een lange tekst met meerdere regels (is het niet no-
dig, mag wel), druk dan gewoon op enter drukken en we beginnen aan de volgende regel.
Een handige tip: maak eerst je tekst(en) in een tekstverwerker b.v. Microsoft Word eventueel
spel of taalfouten worden dan beter zichtbaar. Via kopiëren kun je het dan in de videotekst
plaatsen.
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Er zijn diverse instellingen mogelijk, echter het plaatsen van keyframes is niet mogelijk. Daar-
voor maken we gebruik van het Effect Controls venster. Alle Transformatie-instellingen kun-
nen we invoeren, zoals het toepassen van maskers, uitlijnen, vulling en randen (strokes).
Willen we een open tekst, waarin bijvoorbeeld wolken of water wordt weergegeven, dan is dat
makkelijk te realiseren. Klik op het bekende vierkantje onder het Edit blok en selecteer From
File… Zoek het betreffende foto- of videobestand op. Dit verschijnt vervolgens in het blok als
laag. Het komt wel boven de tekstlaag te liggen. Dus even eronder slepen of de tekstlaag naar
boven slepen. Denk hierbij aan de werking van de lagen in de tijdlijn.
Plaats een vinkje bij het laatste blokje. Zorg wel dat je een lekker groot, dik en vet lettertype
gebruikt, anders zie je weinig.
Zo kunnen we doorgaan om het grafische element helemaal te bouwen. Hebben we in Essenti-
al Graphics helemaal geen laag geselecteerd, dan zien we maar een beperkt aantal functies,
welke we toe kunnen passen op het hele grafische blok, onder andere het bekende Roll effect.
Als laatste: heb je een prachtig grafisch blok gemaakt, dan kun je dit natuurlijk bewaren door
op de betreffende clip te klikken met de rechtermuisknop en vervolgens voor de optie Export
as Motion Graphics Template…te kiezen. Geef het een naam en je kunt het altijd terugvinden
onder de Browse knop.
Ook is er de mogelijkheid om in Adobe After Effects grafische elementen te bouwen en deze
dan als template (voorbeeld) te bewaren. Immers wat je aan het doen bent is niet anders dan
een stukje uit After Effects.

MULTICAM MONTAGE Premiere CC
We hebben een muzieksessie opgenomen met 5 camera’s en 1 los audiobestand als master.
We willen met de Multi-Cam functie een muziekclip maken. De Multi-Cam functie is niet
alleen voor muziekclips, maar kan gebruikt worden voor elke parallel opgenomen scène zeker
als er duidelijke referentiepunten zijn en dan wordt het werken met meerdere camera’s een
leuke optie. Adobe Premiere heeft net als alle andere montagepakketten deze functie al jaren
aan boord maar ten opzichte van bijvoorbeeld de laatste CS-versie is er nogal wat veranderd
en dat proberen we hier uit te leggen. Een ding is zeker. Ik vind het wat makkelijker, maar
oefenen is een must en lees de uitleg eerst helemaal. De belangrijkste handelingen voor het
creëren van multicam vindt nu plaats in het projectvenster.
Tip: als je hieraan gaat beginnen loop eerst door de stappen heen, zodat je weet waar wat zit.
Heb je behoefte aan de oefenclips stuur mij een mailtje en je krijgt ze toegezonden.

< We hebben een project aangemaakt en de bestanden in de projectmap geïmporteerd.
< In het projectvenster selecteren we de clip van de mastercamera en houden vervolgens

Ctrl ingedrukt en klikken op de volgende clip tot we alle clips hebben geselecteerd. De
volgorde van selectie is ook de clipvolgorde (dit is geen moeten maar het mag). Als we
de clips selecteren met de shift toets zullen we op een gegeven moment een foutmel-
ding krijgen.

< Vervolgens klikken we met de rechtermuisknop op de selectie en selecteren ‘Create
Multi-Camera Source Sequence’.

< In het pop-up of dialoogvenster geven we deze sessie eerst een naam en veranderen
alleen dat wat nodig is.

< Onder ‘Synchronize Point’ zorgen we voor deze sessie dat Audio is geactiveerd, dit
omdat we het losse audiobestand als referentie willen gebruiken Premiere zoekt dan
namelijk via de geluidsporen naar de referenties om te synchroniseren. In het blok ‘Syn-
chronize Point’zien we dat we ook kunnen kiezen zoals In en Outpoints, ‘Timecode’
van het beeld en ook die van de audiotrack dit wordt hoofdzakelijk toegepast voor de
camera’s in het duurdere segment welke we hier niet bespreken.
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< Indien we het willen kunnen we alle clips in een aparte map of bin laten zetten, dit
vinkje aan of uit, als alles naar tevredenheid is geactiveerd en/of ingevuld klikken we
op OK.

< In het project zien we dat een Multi-Cam sequence is aangemaakt (icoontje met meer-
dere horizontale lijntjes) deze gebruiken we maar voor een ding en dat is voor het ma-
ken van de uiteindelijke sequence, dit selecteren we en klikken ook hier weer met
rechts en selecteren ‘New Sequence from Clip’.

Vanaf hier is de werking gelijk aan oudere versies van Premiere. Echter: je bent nu niet meer
gebonden aan 4 camera’s, maar kan monteren met zoveel camera’s tegelijk als je wilt.

< In de tijdlijn zal de multicam sequence gemaakt worden en wordt gelijk zichtbaar ech-
ter we zien alleen de beelden van de referentie camera.

< In de ‘Program monitor’ gebruiken we de optie ‘Toggle Multi-Cam View’. We zien nu
wel alle opnames per camera en het beeld voor het eindresultaat in een groter formaat.
Als een en ander niet duidelijk te zien is, beweeg even met de scrublijn over het vide-
ospoor in de tijdlijn.

< We kunnen nu de sequentie afspelen en met de muis of de nummers op het toetsenbord
de diverse camera’s selecteren, in de tijdlijn zien we niks gebeuren buiten dat de scrub-
lijn beweegt.

< Het werken met de toetsenbord optie is wat complexer en je zal wat voorwerk moeten
doen, b.v. uitzoeken wanneer je welke camera actief wil zien.

< Dit gedaan hebbende sluiten we de sessie af door op de spatiebalk te drukken.
< In de tijdlijn zien we nu in het videospoor de nodige knippen of snijpunten staan van

de camerawisselingen.
< Vervolgens kunnen we met het gereedschap ‘Rolling Edit’ de geknipte clips iets aan-

passen, ook kunnen we een andere camera selecteren, als we dat willen door de betref-
fende clip op de tijdlijn te selecteren en in de Program monitor de camera selecteren.
welke we dan willen gebruiken.

< Tot slot vergeten we niet om het project op te slaan en, als we in de Program-monitor
de Multi-Cam optie de-activeren door er op te klikken. kunnen we het eindresultaat in
gewoon formaat bewonderen.

CURSOR (NIET) TERUG NAAR BEGIN NA RENDEREN Premiere
Vraag: Als ik de tijdlijn laat renderen, dan gaat daarna de cursor automatisch terug naar het
beginpunt en begint af te spelen. Ik weet, dat ik ergens een vinkje kan plaatsen om dit te voor-
komen, maar waar?
Antwoord: Ga naar Edit > Preferences. Kies bij CS6 het tabblad  General en bij CC Timeline.
Haal het vinkje weg bij Play work area after rendering previews.

VRAAGTEKENS INPLAATS VAN FILMBEELDEN div. programma’s
Vraag: Plotseling staan er in mijn Premiereproject geen beelden meer op mijn tijdlijn. Al mijn
filmbeelden zijn blijkbaar zoek. Ook vanuit het projectvenster kan ik de shots niet meer ope-
nen.
Antwoord: Wees niet bang. Met je project is niets bijzonders aan de hand en je hoeft echt niet
opnieuw te beginnen. Het ontstaat als het project de bestanden niet meer kan vinden. Het kan
zijn, dat je bestanden op de computer verplaatst heb.
Premiere: Het kan ook zijn, dat je de bestanden in het projectvenster Offline hebt gemaakt.
Als de bestanden op een andere plek staan, dan kom je het meteen tegen, als je het project wil
openen. Het openen stopt dan even en helemaal links bovenin het venster wordt gevraagd naar
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het bestand. Zoek dan het bestand op en klik op Select. Zijn er meerdere bestanden niet te vin-
den, die in dezelfde map staan, dan herkent Premiere die ook meteen en wordt er verder niets
gevraagd. Staan andere bestanden ergens anders, dan zul je de handeling moeten herhalen.
Staan de bestanden bewust offline in het Projectvenster, dan wordt er bij openen van het pro-
ject niet naar gevraagd. Aan de icoontjes is te zien, dat de bestanden offline staan. Je zult de
bestanden vanuit het Projectvenster moeten linken. Op bestand gaan staan, rechts klikken en
link Media kiezen. Opzoeken in de verkenner, het juiste bestand kiezen en vervolgens op Se-
lect klikken. Herhalen tot alle benodigde bestanden weer online zijn.
Studio: Zoek de map op, waar de bestanden in staan. Je kunt dat doen vanuit het bibliotheek-
venster. Klik rechts in zo’n bestand en kies Media opnieuw koppelen. Zoek het bestand op en
kies Openen. Staan meer van die vraagtekenbestanden in dezelfde map, dan heb je grote kans,
dat die meteen gekoppeld worden.

Duidelijk is wel, dat een goede organisatie in de computer zorgt, dat alles soepel verloopt.
Organiseer de boel en maak mappen aan.
Dit probleem kan ongeveer gelijk ook in andere programma’s voor komen met een gelijk-
waardige oplossing.

SUBCLIPS Premiere
In sommige gevallen is het handig om je opnamemateriaal voor de eigenlijke montage in stuk-
jes op te breken en die in je bibliotheek (lees projectvenster) te bewaren. Ik denk daarbij aan
een interview, waar je slechts gedeelten uit gebruiken zal. Of oude VHS-opnamen, die je in
“bulk” op de computer hebt gezet, of een film, waaruit je slechts fragmenten zal gaan gebrui-
ken. Hiervoor kun je gebruik maken van zoge-
noemde subclips.
Het in stukken geknipte materiaal wordt dan
binnen het project als aparte clips opgeslagen.
Let wel op! De subclips staan in het projectven-
ster van je project, maar worden niet als aparte
clips op de harde schijf opgeslagen. Dan zul je
ze een voor een moeten exporteren.
Alle langere clips blijven gewoon bestaan.

De eerste handelingen zijn gelijk aan het gereedmaken van een clipdeel in de Bronmonitor
voor de tijdlijn. Dubbelklik op de clip, die je op gaat delen. Het verschijnt in het Bronvenster.
Geef met de accolades 7 ?onderin het venster het begin en het uitpunt van de toekomstige sub-
clip aan. Kies nu Menu > Make Subclip (ook via rechtsklikken in de Bronmonitor). In het
venster dat verschijnt kun je eventueel de naam van de clip zelf kiezen. De clip wordt wegge-
zet in het projectvenster. Deze handelingen kun je ook doen vanuit de tijdlijn.
Voor de overzichtelijkheid is het natuurlijk ook handig om in het Projectvenster verschillende
mappen te maken, waarin het materiaal gesorteerd weggezet wordt.

AUTO SAVE - AUTOMATISCHE (RESERVE)BESTANDEN div. programma’s
Premiere slaat regelmatig reservebestanden op. Dat is wat anders, dan het automatisch om de
zoveel minuten automatisch opslaan. 
Bij automatisch opslaan wordt bij Studio en sommige andere programma’s het project, waar
je in werkt automatisch opgeslagen. Bij dit programma worden geen reservebestanden ge-
maakt. Bij Premiere (Elements) en een aantal andere programma’s wordt een reservebestand
(back up) opgeslagen. Het project, waar je mee bezig bent, wordt alleen opgeslagen als je zelf
voor save/opslaan kiest. Alle handelingen tot op het moment van opslaan worden in dat reser-
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vebestand, dus een ander project, bewaard. Het is per programma afhankelijk, waar de reser-
vebestanden opgeslagen worden. Meestal staan er dan meerdere bestanden onder elkaar. Stel
je hebt ingesteld, dat er steeds vijf reservebestanden bewaard dienen te worden. Let dan wel
op! Nummer 5 is niet per definitie het laatste bestand. Na nummer 5 wordt nummer 1 weer
opgeslagen. Door naar de datum/tijd te kijken, kun je zien, wat het laatst opgeslagen bestand
is. Dit bestand geeft het minste verlies, ofwel de handelingen tot de laatste opslag zijn hierin
opgenomen. Kies voor bv. opslaan om de 10 minuten. Je bent dan bij een crash o.i.d. nooit
meer dan 10 minuten werk kwijt. Ben je erg onzeker, of doe je ingewikkelde handelingen, die
je zeker wilt stellen, dan kun je voor 5 minuten kiezen.

Automatisch opslaan met Premiere (Elements)
Kies Edit > Preferences > Auto Save (Bewerken > Voorkeuren > Automatisch opslaan). Se-
lecteer Automatically Save Projects (Projecten automatisch opslaan). Geef aan om de hoeveel
minuten Premiere (Elements) het project dient op te slaan. Geef aan hoeveel reserveprojecten
je wilt opslaan. Geef je 5 aan, dan staan er 5 versies van een reserveproject

Een reserveproject openen met Premiere (Elements)
Start Premiere (Elements). Klik in het Welkomstscherm Video Editor aan en klik op Existing
Project (Bestaand Project). Is het programma geopend, kies dan uit de menubalk File > Open
Project (Bestand > Project openen). Open de projectmap en vervolgens de map Auto-Save.
Als het programma crasht, dan komt er bij opnieuw openen van het project automatisch een
melding met de vraag of je de laatst opgeslagen versie wilt openen.

Automatisch opslaan bij Studio
Kies Setup > Projectinstellingen. Vink Bewerkingsomgeving > Projecten automatisch op-
slaan en laden aan. Studio slaat het project, waarin je werkt nu automatisch op. Er worden
geen reserveprojecten aangemaakt. Wil je voor de zekerheid een reserveproject aanmaken,
dan moet je dat zelf doen via Save as (Opslaan als).

EXPORTEREN Premiere
Probleem: film speelt niet goed af door te hoge bitra-
te. Hoe voorkom je dat?
Antwoord: In de bijlage vind je een schermafbeel-
ding van mijn MP4-instellingen.
Als je export hetzelfde moet zijn als op de shots tijd-
lijn, dan kun je Match Sequence Settings aanklikken.
Je krijgt dan een mpg2 bestand. Dan kun je zelf geen
veranderingen aanbrengen in de bitrate e.d. Al die
instellingen worden dan grijs.
De MP4-instelling heb ik zelf gemaakt. Hoe doe je
dat?
Natuurlijk exporteren kiezen. Dan H264. Vervolgens
pas je de instellingen onder de tap video aan. Veran-
der ze zoals je op het plaatje ziet.
Tevreden? Dan kun je die instellingen opslaan onder
een eigen gekozen naam. Je doet dat via het 1e
icoontje naast Preset (Save preset).

Wil je een volgende keer weer die instelling gebrui-
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ken, dan hoef je alleen maar H264 te kiezen en vervolgens bij preset jouw preset.

Aanvulling met aanbevolen instellingen: 
Via het topmenu selecteren we File > Export. In de rechterkolom zien we vervolgens alle in-
stellingen. Zorg ervoor, dat het vinkje verwijderd is bij Match Sequence Settings. Bij Format
kies je een voor jou geschikt format, MPEG4 of H264 (mp4). Beide genoemde formats zijn
aanbevolen voor projectie op de club.
Bij het blok met de 6 segmenten winden we onder de tab Video de bitratesettings. Aanbevolen
voor projectie zijn:
< Bitrate Encoding: VBR, 1 pass
< Target Bitrate (Mbps): 8 of 10
< Maximum Batrate (Mbps): 16 (maximaal). 
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FILMS GEBRUIKEN MET VERSCHILLENDE FRAME RATE Algemeen
Soms maak je in je film naast de je camerabeelden gebruik van beelden van een telefoon of
van YouTube. deze beelden kunnen opgenomen zijn met 30fps, terwijl je camerabeelden met
25fps opgenomen zijn. Bij de montage kan dat botsen met elkaar en dat wordt dan storend
zichtbaar in de uiteindelijke film. Verstandig is het dan om voorafgaand aan je montage de
filmbeelden met 30fps eerst te converteren naar een bestand met 25fps. Er zijn diverse enco-
ders in omloop, die een goed resultaat geven. Premieregebruikers hebben hiervoor de Adobe
Media-encoder, die zijn taak uitstekend verstaat.

In Premiere
In een project staan een aantal clips, die vermoedelijk van YouTube afkomstig zijn. Soms zijn
dit soort dingen nodig om het verhaal compleet te maken. Niets mis mee dus. Maar ....
Vaak hebben deze films een andere Frame Rate (beelden per seconde) dan de instellingn van
jouw film. Je kunt dit in het projectvenster zien, waar al je clips staan. Zorg er dan wel voor,
dat je projectvenster ingesteld staat op bestanden/tekst en niet op beeld.
Om je montage lekker te laten lopen is het verstandig om die beelden vooraf gelijk te maken
aan de beoogde framerate. In ons geval is dat PAL met 25 of 50 beelden per seconde. Dit kun
je makkelijk generen met de Media Encoder, die bij het videopakket van Adobe zit. Werkt
lekker als je meerdere films tegelijk wilt verwerken.
Je kunt de Media Encoder ook vanuit Premiere bereiken. Laad de clip dan in een Premiere
project. Je clip is nu te zien in het Projectvenster. Klik hier met de rechtermuisknop op. Onder
in het pop-up venster zie je Export Media. Klik hier op en je krijgt het venster te zien met de
Export Settings. Kies hier jouw instelling voor het te exporteren filmpjes. Onderaan zie je vier
tabs, waarvan Queue de belangrijkste is, hierop klikken zal het programma Media Encoder
even later openen. Wel even geduld. 
Vergeet niet om de geconverteerde clip weer in het project te laden.

HULPLIJNEN IN CC Premiere CC2019
In het programvenster van Premiere CC2019 zit een nieuw speeltje, dat al jaar en dag ook
door Photoshop gebruikt wordt. Het zijn de lini-
aal en de hulplijnen, ofwel rulers en guides. Op
diverse plaatsen in je scherm kun je imaginaire
lijnen plaatsen, om een beeld of tekst netjes ge-
plaatst te krijgen. Geen gedoe meer met uitzoe-
ken, waar iets moet komen te staan. De lijnen
geven het steeds aan. Je gebruikte lijnenspel
kan opgeslagen worden en uiteraard zijn de lij-
nen in je uiteindelijke beeld niet zichtbaar.

De werkwijze:
1. Je zorgt dat de liniaal en de hulplijnen

getoond worden via View > Show Rulers
en Show Guides. Je kunt ook via het plusteken rechts onderin de 2 knoppen in het rijtje
onderaan toevoegen. Voor video zorg je er natuurlijk voor, dat je liniaal op pixels ing-
esteld is. Immers het meest gebruikelijke videobeeld is opgebouwd uit 1920x1080
pixels.

2. Nieuwe hulplijnen kun je aanmaken via View > Add Guide. Simpeler is Rechtsklikken
en vervolgens te kiezen voor Add Guide. In het venster kun je aangeven waar de hulp-
lijnen komen te staan. Je kunt een kleur aangeven en of ze verticaal of horizontaal ge-
plaatst worden. Je kunt ook simpelweg vanuit de liniaal een hulplijn “trekken”,
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3. Vervolgens kun je je elementen positioneren. Het kan een videoclip zijn of een gra-
fisch element. Om perfect te positioneren kun je de hulplijnen verankeren via View >
Snap. Toch niet tevreden? Weer “losmaken” en je kunt de lijn eenvoudigweg verschui-
ven.

4. Wil je de door jou gemaakte hulplijnen bewaren voor later gebruik, dan kun je het op-
slaan. Ga dan naar View > Guide Templates > Save Guides as template. Om templates
(voorbeelden) te hernoemen, importeren of exporteren ga je naar View > guide Tem-
plates > Manage Guides.

BROADCAST COLORS Alle programma’s
Bij kleurencorrectie kom je in veel programma’s de term, het effect of de filter Broadcast Co-
lors tegen. Je opgenomen kleuren konden veel uitgebreider zijn, dan een tv, een monitor of
internet aankon. Dus kon je het omzetten naar de zogenaamde veilige kleuren, zodat alles bin-
nen het gangbare kleurengebruik viel.
In de nieuwere versies van Premiere blijkt die functie verdwenen te zijn. Een telefoontje met
Adobe heeft aangegeven, dat dit bewust uit de montagepakketten gehaald is. Onze huidige
monitoren, tv’s enz. zijn van een dusdanige kwaliteit, dat een dergelijk filter totaal overbodig
is geworden.
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GELUID

MUZIEK DOWNLOADEN
Vraag:  Ik heb in het verleden een icoontje op mijn bureaublad gehad voor het configureren
van muziek en dat ging redelijk, maar het icoon ben ik kwijt geraakt, volgens mij door steeds
nieuwe update Maar dit schijn toch steeds lastiger te zijn of te worden ook volgens mijn doch-
ter, die het ook moeilijker gaat vinden. Als ik een
site aan click, dan wordt ik naar een volgende site
geloodst, wat haast altijd ook nog Engels is. Of
moet ik gaan betalen om muziek te downloaden.
Volgens de meeste is dit gesneden koek maar dan
waarschijnlijk niet voor mij.
Antwoord: Er is voldoende rechtenvrije muziek te
downloaden, die betaald dient te worden. Wil je
gratis muziek downloaden, dan is het even zoe-
ken. Een paar sites zijn bijvoorbeeld: Find-
Sounds.com en Intervox. Kijk eens op websites
van diverse videoclubs. Zij hebben vaak links
staan naar dergelijke sites. Je kunt ook muziek downloaden van YouTube. er zijn diverse pro-
gramma’s, waarmee je dat kunt doen. Een goede mogelijkheid is bijvoorbeeld YopuTube con-
verter - downloader. Ook met Gemistdownloader is goed te werken. Hiermee kun je zelfs tv-
programma’s downloaden. Ook met de bekende VLC-mediaplayer is het mogelijk.

AUDIOMIXER Premiere
Vraag: Hoe hoog moet het geluid van de tijdlijn staan
en wat is de Master in de audiomixer.
Antwoord: Allereerst staat de belofte om dit alles nog
eens goed voor te bereiden en een volgende keer op
een rijtje te zetten.
Het voorproefje, dat we nu al gaven:
Als je het venster Audiomixer opent, dan zie je diverse
sporen staan naast elkaar. Speel je de tijdlijn af en heb
je op meerdere sporen geluid staan, dan kun je in de
audiomixer per tijdlijn het geluid zien. In de Master
(helemaal rechts) zie je de mix van alle tijdlijnen.
Je kunt per tijdlijn het geluid aanpassen via de schuif-
jes, maar je kunt ook het totaal aanpassen in de Mas-
ter.
Dan de getallen naast de diverse audiolijnen. Links
staan de decibels (db) en rechts staan de getallen voor
loudness. Je ziet, dat loudness (luidheid) het getal 0 als
hoogste waarde heeft en dat komt niet overeen met de
0 bij de decibels. Ga je dus het geluid zachter maken to bv. -6 db, dan staat dat niet gelijk aan
-6 bij de loudness.
Geadviseerd wordt om de getallen van de loudness aan te houden.

Wat is loudness? Wikipedia geeft aan: Luidheid of loudness is een grootheid die op een objec-
tieve manier het subjectief beleefde geluidsniveau weergeeft. Het wordt bepaald voor een per-
soon met een gemiddeld gehoor.
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AUDIO DUCKING
Je hebt livegeluid, muziek en een voice-over in je film. Dan is het altijd een heel karwei om
een mooi evenwicht tussen het geluid te krijgen. Premiere CC (wel of niet in samenwerking
met Audition) kent Audio Ducking. Hiermee kun je de boel automatiseren. Jan S. heeft dit
laten zien, zoals de handeling tot nu toe in Audition gedaan werd. In Premiere CC 2019 vind
je Essential Sound ook direct in Premiere. Lees ook het artikel van Jan in de Explicateur van
mei 2018-blz. 17.
Het stuk, dat gebruikt is bij de uitleg vind je hieronder:

We hebben een Multitrackproject geladen of via Dynamic Link een sequence vanuit Premiere
Pro. Hierin hebben we naast het livegeluid (Ambience) ook een aantal sporen met dialoog en
muziek. Ik begin meestal met minimaal twee sporen van elk
audio type (Dialoog, Muziek, Ambience en Sound effecten). 
We blijven bij de eerste twee, dialoog en muziek, en zorgen
dat Loudness op 0dB staat voor beide. Vervolgens selecteren
we in de dialoog sporen de tekstblokken, het Essential Sound
panel wordt hierdoor geactiveerd, en klik vervolgens op Dia-
logue.
De volgende stap zal zijn, dat je de muziek selecteert en geef in het Essential Sound panel aan
dat dit Music type is. Nu komt het mooie, je ziet in het panel Loudness, Duration en Ducking.
Ook zie je, dat de vierkantjes achter de laatste twee leeg zijn (geen vinkje). Klik in het vier-
kantje achter Ducking en de tool wordt actief. Als je nu kijkt in het Multitrack panel naar het
spoor, waar de muziek in staat, dan zal je zien dat de muziek ten opzichte van de dialoogtekst
is bij gesteld met een fade in en out. Omdat je al de dialogen hebt geselecteerd zal het icoontje
achter Duck against geactiveerd zijn
(blauw).
Vervolgens zien we vier instellingen,
die we naar eigen inzicht kunnen aan-
passen: Sensitivity, Reduce by en Fa-
des en het vinkje onderin het panel bij
Monitor clip changes bewaren tot het
eind. Sensitivity zegt het al, de fijn-
gevoeligheid ten opzichte van dialoog zet je deze op laag, dan zal bij elke adempauze het ni-
veau weer wijzigen. Met muziek Reduce by geven we aan hoeveel het muziek loudness (db)
omlaag moet ook ten opzichte van de dialoog en bij Fades kunnen de fade in en out aangepast
worden.
Als laatste Monitor clip changes. Wat hiervoor gebeurt is natuurlijk allemaal prachtig, maar
voldoet het aan je persoonlijke wensen? Dat telt ook mee. Nu stel, dat je toch een of ander
zeker met betrekking tot de automatisch verkregen stippellijn wilt wijzigen. Klik op het vinkje
en de stippellijn zal een lijn met keyframes worden nu kunnen we keyframes verwijderen of
toevoegen.
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PHOTOSHOP

AFBEELDING UITSNIJDEN VOOR GREEN SCREEN

Selectie met vierkant
Open Photoshop.
Linksboven staat BESTAND > OPENEN en zoek het plaatje. In het gereedschapsven-
ster staat links bovenin een vierkantje, RECHTHOEKIG SELECTIEKADER.
Aanklikken en ingedrukt houden en een keuze maken. Rechthoek is het meest ge-
bruikt. Ga nu naar STIJL in de regel boven het venster. Daar zijn drie mogelijkheden:

1. NORMAAL. Hiermee kan je de maat van de rechthoek zelf bepalen
2. VASTE VERHOUDINGEN. Als je de vaste verhoudingen op Breedte 16 en hoogte 9

dan zit je automatisch op de HD-uitsnijding.  Dit wordt het meest gebruikt. Wil je een
verticale uitsnijding maken. dan zet je de breedte op 9 en de hoogte op 16.

3. VASTE GROOTTE. Gebruik ik nooit, maar hier kan je een vaste afmeting invullen bij
Stijl.

Als je een fout heb ge-
maakt bij het selecteren,
ga dan naar SELECTE-
REN (boven in het
scherm). Klik hierop en
klik dan op DESELECTE-
REN en je kunt opnieuw
beginnen.
Als je de rechthoek hebt
geselecteerd, trek dan met
de muis een rechthoek in
het venster. Het rechthoek-
kader kan je nog met de muis verplaatsten. Ga naar BEWERKEN > KNIPPEN of KOPIEREN.
Er ontstaat nu bij knippen een wit vlak in de foto en bij kopiëren blijft de foto intact. Het oude
scherm kan je nu verwijderen. Hier doe je verder niets mee maar klik op Nee in het venster
wat verschijnt.
Ga naar bestand Nieuw (Linksboven) en er verschijnt weer een scherm. Ga naar BEWERKEN
> PLAKKEN en de uitsnede staat nu in het scherm. Opslaan bij FORMAAT in het schermpje
als JPEG in je afbeeldingenmapje voor montageprogramma. Wel even een naam er aan geven.
Ga naar AFBEELDING > AANPASSEN en je kunt belichting / kleur aanpassen.

Selectie met Magnetische Lasso
Open Photoshop. 
In de gereedschapstrook, links in het venster, staan  bijna onderaan twee kleurvak-

ken. Klik op het bovenste vakje en selecteer de kleur groen voor GREEN-
SCREEN met de muis in het kleurenscherm. OK. Het voorste vakje is u nu
groen.
Ga naar BESTAND / OPENEN en PLAATJE zoeken. De afbeelding staat
nu in het scherm. We gaan nu de uitsnede maken van de foto.
Ga in de gereedschapstrook naar MAGNETISCHE LASSO SELECTIE en klik op
MAGNETISCHE lasso (Tweede vakje linksboven in de gereedschapstrook). Er ver-

SGD Uitleg 2019_20 57 of  61



schijnt nu een soort driehoekje als je naar het scherm gaat. Klik met linkermuisknop
op een beginpunt met een muisklik, houd de muis ingedrukt en trek een lijn langs de
afbeelding. De lasso volgt de lijnen vanzelf (magnetisch). Bij moeilijke bochten en/of
weinig kleurverschil een punt neerzetten met de muisknop. De muis even loslaten en
weer klikken en de lijn verder trekken tot dat je helemaal rond bent. Je kunt net zo-
veel punten neerzetten als je wilt. Als je weer bij het begin bent aangekomen is de
selectie rond en gaat de lijn knipperen. Mocht je fout hebben gemaakt, ga dan naar
SELECTEREN/DESELECTEREN en je kunt het opnieuw proberen.
Ga nu naar BEWERKEN > KNIPPEN of KOPIËREN. Bij knippen is de afbeelding uit
het scherm. Bij kopiëren blijft het scherm intact. Wij kiezen even voor Kopiëren. Het
oude scherm kan je nu verwijderen. Niet opslaan.
Ga naar BESTAND > NIEUW > OK. Er staat nu een leeg scherm in het beeld, dat
automatisch is aangepast naar de maat van de uitsnijding. Ga naar BEWERKEN >
VULLEN en kies in het uitrolscherm VOORGRONDKLEUR. Het venster wordt nu
groen. Ga naar BEWERKEN > PLAKKEN en de afbeelding staat nu in het groene scherm. Met
het penseeltje (4e rij van boven en het rechtse vakje) kan je oneffenheden nog bijwerken. In de
bovenbalk kan je de grootte van het penseel aanpassen.

De afbeelding gaan we nu verkleinen om er later makkelijker mee te kunnen werken in de
montage.
Ga naar BEWERKEN > VRIJE TRANSFORMATIE. Het hele afbeeldingsvenster is nu geselec-
teerd. Ga met de muis naar de linker bovenhoek en klik in de hoek en houd de muis ingedrukt.
Verklein de afbeelding maar het moet nog wel redelijk te zien zijn. Zorg wel dat de verhou-
ding ongeveer goed blijft. Klik op de afbeelding en zet de afbeelding in het midden van het
scherm. Dubbelklik op de afbeelding en de selectieranden verdwijnen.
Ga nu naar LAAG > Een LAAG maken onder in het scherm. Bestand / Opslaan als .. / keuze
zelf bepalen. Ik zet de afbeelding altijd eerst op het bureaublad, zodat ik het later in de goed
map kan zetten.

Tip: door tijdens de transformatie de Shifttoets ingedrukt te houden blijft de verhou-
ding gelijk. Bovenin het venster staan twee hokjes voor hoogte en breedte. Door hier
de getallen te wijzigen kun je het formaat ook veranderen.

Selectie met toverstaf
Open Photoshop.
In de gereedschapstrook, links in het venster, staan  bijna onderaan twee kleurvak-
ken. Klik op het bovenste vakje en selecteer de kleur groen voor GREENSCREEN
met de muis in het kleurenscherm. OK. Het bovenste vakje is u nu groen.
Ga naar BESTAND > OPENEN en zoek een PLAATJE op. De afbeelding staat nu
in het scherm. We gaan nu een precieze uitsnede maken in de afbeelding. Ga in het

gereedschap venster naar de TOVERSTAF. Van boven tweede rij en dan
het rechtse vakje in het gereedschapvenster. Deze kan je het beste gebrui-
ken als de achtergrond een egale kleur heeft. Klik op de Toverstaf en klik daarna in
de egale achtergrond kleur. Meerdere kleuren kan ook, maar dan moet je met de To-
verstaf kleur voor kleur selecteren en verwijderen.
Je ziet dat er met stippellijnen er een selectie heeft plaats gevonden. Alles is nu gese-
lecteerd, maar we hebben alleen het vliegtuig nodig. Ga
nu naar SELECTEREN (bovenste regel) en daarna SE-
LECTIE OMKEREN. Nu is alleen het vliegtuig geselec-

teerd.
Mocht je een fout hebben gemaakt, ga dan naar SELECTE-
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REN/DESELECTEREN en je kunt het opnieuw proberen. Ga naar BEWERKEN > KNIPPEN
en het vliegtuig is er uitgeknipt.
Het venster kan je nu verwijderen door op het kruisje rechtsboven te klikken. Niet opslaan!
Ga weer naar BESTAND > NIEUW. In het venster OK. Er staat nu een blank venster in beeld.
Ga nu naar BEWERKEN > VULLEN > VOORGRONDKLEUR en het scherm is nu GROEN.
Ga naar BEWERKEN > PLAKKEN en het vliegtuig staat in het groene vlak.

De afbeelding gaan we nu verkleinen om er later makkelijker mee te kunnen werken in de
montage. Ga naar BEWERKEN > VRIJE TRANSFORMATIE.
Het hele afbeeldingsvenster is nu geselecteerd. Ga met de muis naar de linker bovenhoek en
klik in de hoek en houd de muis ingedrukt. Verklein de afbeelding, maar het moet nog wel
redelijk te zien zijn. Zorg wel dat de verhouding ongeveer goed blijft. Klik op de afbeelding
en zet de afbeelding in het midden van het groene scherm. Dubbelklik op de afbeelding en de
selectieranden verdwijnen.
Ga nu naar LAAG > Een LAAG maken, onder in het scherm. Bestand / Opslaan als .. / keuze
zelf bepalen. Ik zet de afbeelding altijd eerst op het bureaublad, zodat ik het later in de goede
map kan zetten.

UITBREIDING SELECTIES
Je kunt in Photoshop op diverse manieren een selectie maken. Je kunt hiervoor de grafische
vormen gebruiken, zoals het vierkant, de cirkel, enz. Maar ook de toverstaf e.a.
Bij de grafische vormen is er een leuk foefje. Maak je de vorm met ingedrukte Shifttoets bij
het selecteren, dan wordt het vierkant echt vierkant en niet rechthoekig, of de cirkel keurig
rond en niet ovaal.
Alle selecties kun je uit-
breiden of een stuk van
de selectie weghalen
zonder opnieuw te moeten beginnen. Bovenin het menu zie je naast het geselecteerde gereed-
schap een viertal symbolen staan. Als je goed kijkt, dan wijst het zich vanzelf. Uiterst links is
het symbool voor simpelweg een selectie maken. Selectie klaar en klik je ergens in de afbeel-
ding, dan is de oude selectie verdwenen. Bij het 2e symbool kun je een stuk selectie erbij ma-
ken. Heb je te weinig geselecteerd, ga dan met de muis over het deel, dat je erbij wilt selecte-
ren. Je selectie wordt uitgebreid. Je kunt hiermee eindeloos doorgaan. Bij het 3e symbool
wordt er deel van de selectie afgehaald. Bij het 4e symbool kruist de selectie de al
bestaande selectie. Probeer het eens uit om het in de vingers te krijgen.

Nog een paar tips:
1. Wil je zien of je selectie naar de zin is, ga dan tijdelijk naar het masker (he-

lemaal onderin de gereedschapbalk. Je kunt dan precies zien, wat je geselec-
teerd heb, Alles daarbuiten heeft de maskerkleur. Ga je weer uit het masker,
dan ben je weer in de gewone afbeelding met de gemaakte selectie. In het
masker kun je eventueel met de gum (weghalen) of het potlood/kwast (erbij
maken) de selectie bijwerken.

2. Om wat gladdere randen te krijgen kun je de Feather op een paar pixels in-
stellen. De rand wordt dan wat vager en geeft niet die scherpe ‘foutjes’ weer,
die duidelijk laten zien, dat je aan het uitknippen geweest ben.

VLIEGTUIG ROUTE MET STIPPELLIJN OF RODE STREEP
Eenvoudige uitvoering.
Zoek in Google een landkaart van de wereld of een bepaald land. Opslaan in het
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goede mapje. Open in Photoshop via Bestand > Openen > Plaatje van de wereld of land. In
ons voorbeeld nemen wij een kaart van de wereld. Kleur het kleurenvakje met de kleurenkie-
zer BLAUW of ROOD. 
OK. Ga naar het penseel in het gereedschapvenster. Linksboven kan je bij PENSEEL de groot-
te bepalen van de stip, bv.12. Zet de eerste stip op het beginpunt, bv. Nederland. Zet nu de
stippen naast elkaar met een kleine tussenruimte zodat het een lijn wordt naar het eindpunt.
Opslaan in het mapje als JPG. Wel een goede naam geven, bv. wereldkaart met stip.

CARTOON VERWERKT IN EEN FOTO
Zoek in Google > Cartoon/wandelen/Afbeelding en zoek ook een foto van een bos. Let op de
het bestandsformaat, zoals al een keer is uitgelegd. Sla op in een mapje.

Selecteer in het kleurenvierkant de kleur groen voor Greenscreen, zoals eerder is uitgelegd.
Het voorste vakje is nu groen. Ga naar Bestand > Openen. De afbeelding zoeken en in het
scherm plakken. De afbeelding staat nu in het scherm. Soms moet je met het gummetje over-
bodigheden of een naam weggummen.
We gaan nu een precieze uitsnede maken van de afbeelding.
Ga in het gereedschap venster naar de Toverstaf. Van boven tweede rij en dan het rechtse vak-
je in het gereedschapvenster. De Toverstaf kan je het beste gebruiken als de achtergrond een
egale kleur heeft. Klik op de Toverstaf en klik daarna in de egale achtergrondkleur. Meerdere
kleuren kan ook, maar dan moet je met de Toverstaf kleur voor kleur selecteren en verwijde-
ren. Je ziet dat er met stippellijnen er een selectie is gemaakt. Het hele scherm is nu geselec-
teerd, maar we hebben alleen de cartoon nodig.
Ga nu naar Selecteren (bovenste regel) en daarna Selectie Omkeren. Nu is alleen de cartoon
geselecteerd.
Mocht je een fout hebben gemaakt, ga dan naar Selecteren / Deselecteren en je kunt het op-
nieuw proberen.
Ga naar Bewerken > Knippen en de cartoon is er uitgeknipt. Het venster kan je nu verwijderen
door op het kruisje rechtsboven te klikken. Niet opslaan!
Ga weer naar Bestand > Nieuw. 

In het nieuwe venster verander je Breedte in 5000 en de Hoogte in 3000. Je krijgt dan een
groot masker, dat straks in Studio geen witte zijstrepen meer geeft. In het venster OK.
Er staat nu een blank venster in beeld. Ga Naar Bewerken > Vullen > Voorgrond Kleur > OK.
Het scherm is nu GROEN.
Ga naar Bewerken > Plakken en de cartoon staat in het groene vlak. De afbeelding gaan we nu
verkleinen om er later makkelijker mee te kunnen werken in de montage.

Ga naar Bewerken > Vrije Transformatie. Het hele afbeeldingsvenster is nu geselecteerd. Ga
met de muis naar de linkerbovenhoek, klik in de hoek en houd de muisknop en de Shifttoets
ingedrukt, zodat dat de verhouding goed blijft. Verklein de afbeelding, maar het moet nog wel
redelijk te zien zijn. Klik op de afbeelding en zet de afbeelding in het midden van het groene
scherm. Dubbelklik op de afbeelding en de selectieranden verdwijnen. Ga nu naar Laag > Eén
Laag maken, onder in het scherm. Kies Bestand > Opslaan als .. (naam zelf bepalen) en plaats
in het goede mapje.

Landgedeelte uitlichten
Zoek een afbeelding van een land in Google met egale kleurvakken. Dit is makkelijker om te
selecteren. Open Photoshop.
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Bestand Openen > Afbeelding Kaart. Selecteer de Toverstaf en selecteer het gedeelte wat je
uit gaat knippen. Bij meerder vlakken de Shifttoets indrukken. Ga naar Bewerken en knip of
kopieer het geselecteerde. Kies Bestand > Nieuw. Maak de Breedte 5000 en de Hoogte 3000
in het scherm. OK.
Ga naar Bewerken > Vullen > Voorgrondkleur > OK. Als het goed is wordt het scherm nu
groen. Kies Bewerken > Plakken in het groen lege scherm. Het uitgeselecteerde gedeelde staat
nu in het groene scherm.
Ga naar Bewerken > Vrije Transformatie en Afbeelding >  Evt. Kleiner Maken. Na het kleiner
maken weer in het midden zetten en dubbelklik in de afbeelding zodat de selectielijnen ver-
dwijnen.
Ga naar Lagen > Een Laag maken. Dit scherm opslaan in het mapjeplaatsen, waar de eerste
kaart staat.

CLIPART UIT BIBLIOTHEEK VERDWENEN Photoshop Elements
Vraag: Omdat ik op alle knopjes graag druk heb ik - natuurlijk abusievelijk -  in het fotopro-
gramma Elements het pictogram met de afbeelding fotograaf verwijderd. Dat staat aan de
rechterkant onder Maken > Op Activiteit > Klussen > Alles tonen. Dan komen er leuke grafi-
sche figuurtjes tevoorschijn. Behalve nu mijn fotograafje. Is echt uit het programma verdwe-
nen. Weet jij misschien een oplossing?
Antwoord: Om deze vraag te beantwoorden heb ik een proefversie van Photoshop Elements
gedownload. Als je deze ‘map’ toont, dan kun je de cliparts gebruiken in de foto, waarmee je
bezig bent. Door rechts te klikken op de afbeelding in deze bibliotheek komen er een paar op-
ties te voorschijn. Een daarvan is ‘afbeelding verwijderen’. Heb je daarop geklikt, dan is de
afbeelding verdwenen uit de catalogus. Bij mijn poging bleek de afbeelding ook van de schijf
verdwenen te zijn. Dus niet zo maar terug te halen. Ik heb geen optie herstellen gevonden. De
afbeeldingen zijn te vinden in: C > ProgramData > Adobe > Photoshop Elements > 18.0 >
Photo Creations > Graphics. De versie (18.0) kan natuurlijk verschillen van het gebruikte pro-
gramma. En de map Graphics kan een van de andere mappen zijn in de map Photo Creations.
Bij je installatie van DVD of anderszins is bij het openen (dus niet installeren) deze map ook
te vinden. Probeer dan de afbeelding te kopiëren naar bovenstaande map. Grote kans, dat de
clipart weer in je bibliotheek te voorschijn komt.
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